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1 Introduction

Today's customer demands more flexibility and customization possibilities than
“physical configurations” can offer. With new Philips configurable devices with built-in
controls or separate controllers you can configure the luminaire’s behavior. You can
control output levels, or even pre-configure dynamic dimming on the client’s request;
either directly in the factory or during installation on location. All you need is ONE
intuitive tool that when plugged into a device can calibrate ALL the different
functions required by any lighting solution.

Creating the perfect lighting solution has been made very easy with Philips MultiOne.

With MultiOne, you can configure all features that are supported by a Philips device.
A feature typically belongs to one or two product groups (LED Indoor/Outdoor, HID
or FLUO), but this does not mean that every device from a product group does
support all features.

Philips MultiOne is supported by Windows 7 SP1, 8, 8.1 and 10 operating systems. It
works only in combination with the Philips LCN8600 MultiOne interface USB2DALI,
with Philips LCN8650 MultiOne interface USB2ZigBee, Philips LCN9600 (Engineering
interface, basic use only), LCN9610, LCN9620 or LCN9630 (Under investigation)
MultiOne interface SimpleSet®.



2 Table of contents

1 INEFOAUCTION oottt 2
3 SYSTEM FEQUITEMENTS ...ttt st 8
4  Downloading and installing MultiOne and the documentation package.................... 9
5 ALEENTION POINTS ..ottt naeen 10
5.1 GENEIAL ettt e 10
5.2 DALttt 10
5.3 SIMPIESEt® INtErFACE ......ceveeeeeee e 10

6 The MUIIONE INTEITACES ....coueeeeecci ettt 11
B. 1 DALL ettt 11
0.2 ZIGBEE ..o 12
8.3 SIMPIESELY ..o 12

7 STArtING MUIION ... ..ttt 13
7.1 Activating MURTONE ...ttt 13
7.2 Application MOdE SEIECLON ...t 16

8 Selecting the INtErface......o ettt 17
8.1 Interface AUtO dELECLION ...t eseees 17
8.2  Interface Manual SEIECTION ...t 17
821 ATE-NET ettt 18

9 Working with the Philips LCN8600 MultiOne interface USB2DALI..........ccccocomrunrunnee 20
9.1 The main application WINAOW ........c.ccoueiririeniiniieieieiesissie e ssessssesssssss e 20
9.2  Managing the DALL NEIWOIK.......ccoviriririiriieieieieeieeisise e sssssssssssssss e 20
9.2.1  IdeNtifying EVICES ...ttt sseees 20
9.2.2 Selecting devices for COMMUNICAtION ... 23
9.23 Managing user-defined groups ... seesessens 24
9.24  MaNAGING GrOUPS ...ccuuvureumeureemniurerireeseeisesiseasesssessstssesssessesssesssessesssesssessesssessesssesssesneses 25

10 Working with the Philips LCN8650 MultiOne interface USB2ZigBee..........ccccouveune... 29
10.1  The main application WINAOW ... 29
10.2  Connecting to a ZigBee NEtWOIK ... 29



10.2.1  IAentifying dEVICES ...ttt sssnsaes 29

10.2.2 Selecting devices for commMUNICAtION ..o 30
10.3  Advanced COMMISSIONING......coviuiririenieriirrireieieeseeesstseiss s ssssssssss s ssssssesssssssessns 30
10.3. 1  IAentifying dEVICES ...ttt sssnsaes 30
10.3.2 MaNAGING NEIWOIKS ...ttt sttt ssasssssans 30
10.3.3 MaNAGING ZONES ...ttt bbbt 31
11 Working with the Philips MultiOne SimpleSet® interface(s)..........ccomeevermreeeveeenene. 33
11.1 The main application WINAOW ..o ssssesesssesaees 33
11.2 Scanning a SIMPIESEt® EVICE ... 33
1121 Identifying dEVICES ...ttt ssssesees 33
11.2.2  AULO MU ...ttt 34
113 Selecting devices for COMMUNICAtION ..o 34
114  Starting COMMUNICATION ..ot sees 34
12 Working With MUITIONE. ... eeaeen 35
121 Viewing deVICE PrOPEITIES .....ocviuiuieeeeeereereireireieeeteseeseese et sssess s ssseasesseens 35
122 Communicating With @ deVICE........cccovirirreeer e 35
12.3  Configuring deviCe fEATUIES. ...t 36
1231 0-10V / 1-10V et ss st sss st sssessessss st sssssssssssnnes 40
1232 L-L0V ettt 41
1233 ACtiLUME GENETAL ..ot 42
1234 ACHLUME MOttt eeseen 43
1235 ACHLUME SCONE ...ttt een 45
1236 ACHIVE COOLING coiiii sttt sssnes 45
12.3.7  Adjustable Light OULPUL ... eeeeeeees 46
12.3.8  Adjustable Output CUMENT ...t eaeeeeeees 47
12.3.9  Adjustable Startup TiME ...t sssssaees 47
12.310  AMPDIM ittt 48
12311 Coded Light On and Off .....cceineneneneeieeiseesesesesssesseesssesssessseseees 48
12312 COAEA MAINS ..ottt ss s 49
12.3.13 Coded Mains Standalone RECEIVET ... eeeeneeees 50



12.3.14
12.3.15
12.3.16
12.3.17
12.3.18
12.3.19
12.3.20
12.3.21
12.3.22
12.3.23
12.3.24
12.3.25
12.3.26
12.3.27
12.3.28
12.3.29
12.3.30
12331
12.3.32
12.3.33
12.3.34
12.3.35
12.3.36
12.3.37
12.3.38
12.3.39
12.3.40
12341
12.3.42
12.343

Constant Light OUELPUL ..ot 50

Correlated Color TEMPEIAtUIE ... 53
COrTIAON MOttt 54
DALL 02 ..ottt 55
DALI POWET SUPPIY oottt sss s ssssssssasssesnns 56
Daylight override / Daylight sWitChing .......cocovvreieinirreeeeene 56
DC EMEIGENCY .ttt st 57
DEVICE INTO vttt ss s 57
DIimMMING INTEITACE ...ttt anees 58
DIIVEr @dArESSING .ccouivieieiieieeeieieie ettt sssssenes 59
Driver temperature proteCtion ..........ceeieineineenenesesssse s ssssssessesssesans 60
DWEIT TIMIE oottt 61
DYNAAIMMIET ...ttt enenes 62
ENnd Of Life iNAIiCatioN ..ot sssesas 64
ENEIGY METET ...ttt 65
FCC et et 65
Field Task TUNING ..ottt sssssnes 66
Field Task Tuning / Occupancy Sensing / Daylight Harvesting............... 67
LAMIP BUIN=IN oottt 68
LaMP SEIECTION ...ttt nes 68
Light Source Operating HOUTS ... eeeeeees 69
LIN@SWITCN oot 69
Load Fault Indicator Thresholds..........c.oenneneseeseeeseseeirei 70
Logical Signal INPUL ...t eeeeeees 71
LUMEN LOVEL ...t 72
LUMIISTEP ettt naen 73
IMIN DM LEVEL ...ttt ees 73
Module Temperature ProteCtion ... eeeeeseeees 74
NTC ON LEDSEL ...ttt nnes 75
Occupancy Sensing / Daylight Harvesting........cocccvcnenecncenenecneeecnennne 76



12.3.44  Occupancy sharing / Group light behavior..........ccnennninns 77

12.345  OEM Tracability ...t 77
12346  OEM WIite Prot@CioN.. .ttt eeseasesesaens 78
12.3.47  Push Button Unit LCU2070 .......ccoveumeeneeneinecireieeineeereeeeiseesseiesesessesssesssessesenes 79
12.3.48  Push Button Unit LCUZ07T ... sesseeeseenees 79
12.3.49  QUICK LamP STAIt ...ttt ees 80
12.3.50 Relay SWitched OULPUL ...t 80
12.3.51  SEEP DIMMING .oiiiiiiriirieieieisteeeie ettt sttt s s s sassas 81
12.3.52  TOUCH @Nd DIM .ottt een 82
124 Using the features SUMMAIY ...t ssssssssssseesns 83
12.5  Saving and opening a feature configuration file.........ccccoomrnroninrnrininninns 83
126 Configuring @ SiNgle dEVICE........o.ooieeerereere et 86
12.7  Configuring multiple DALI devices (simultaneously) ... 86
128  Configuring multiple DALI devices (cONSecUtively) ........cocoevrrereenreeneeneeneenrins 87
12.8.1 IMUIIONE BASIC ..ottt 87
12.8.2 MUIEIONE (FUIT VEISION) ettt s s s aenns 87
129  Configuring multiple ZigBee deViCes........corininiineieieeesessiseise e sesseesens 88
12.10 Offline feature configuration Preparation ... 88
1211 Sending DALI COMMANGS ...ttt sesssssss st ssssssssssssssessns 89
12,12 TraCEADIIILY oottt 91
1213 Working with DALL command SCIPLS ..o eseseeeeeens 92
1214 QUEIYING EVICES ..ccveririeieeeeeieieiseieie ettt sss st ssss s s ssssasssessns 94
1215 AcCeSSING AIAQNOSTICS ...euveveieeeiiiirieieie ettt sasnsssens 94
1216  Working with the DALL SNIffer ... 100
12.16.1  Sniffing with multiple iNterfaces ... 101
1217  Art-Net export fuNCLIONAIILY ..o, 101
12,18  The 10gging WINAOW ...ttt sesesseessesesessesssessssesans 102
1219 Setting Prefere@NCES ...ttt snseses 103
12.19.1  General PrefereNCES ...t sase st ssssas 103
12.19.2 DALttt sttt 105



12.19.3  UPALES .ottt 106

12,194 PrOXY oot ssesssss st st sssss s sss st st sssss s ssss st st ssssssss s ssssssssssseses 107
1220 Manually selecting the USB2DALIL interface.........c.oovevnreernrenrierenneensiesessioenens 107
12.21 Enabling/Disabling the power supply of the USB2DALI interface................. 108
12,22 SUPPOILEd fEALUIES ...ttt s s ssenaes 108
12.23  Device-specific technical descriptions .......c..coccereernrinrnsinsieess s 110
1224 Error RandIiNg ...ttt sttt 110

12.24.1 Reporting and correction of errors/warnings when reading from a...110

feature coNfigUIation fil@ ...t sees 110
12.24.2 Reporting of errors when reading from a device ........ccccoovivrvrerinnnnnn. 111
12.24.3 Reporting of errors when entering incorrect values in a feature.......... 111
1225 TroUubI@ShOOTING ... 111
13 KEYDOArd SNOMCULS......ceieierieicet ettt st 113
14 SOFtWAIrE UPAAte......oeeeieieiiiicieiets sttt 114
15 COPYTIGNT st 116
16 DUSCIAIMIET ..ottt 117
17 Limitations Of damMages...... ittt 118
18 LISt OF LADIES oottt 119
19 INAEX ottt 120



3 System requirements

The minimum system requirements for using MultiOne are:

- PC or laptop with Microsoft Windows 7 SP1, 8, 8.1 or 10
- USB 2.0 ports:
o Two free USB 2.0 ports for use with USB2DALI interface
o One free USB 2.0 port for use with USB2ZigBee interface
o One free USB 2.0 port for use with SimpleSet® interface
- Ethernet port:
o One free Ethernet port for use with Art-Net protocol
- At least 45 MB of free disk space
- Microsoft .NET Framework 4.6.1 (download here for offline installation)



https://www.microsoft.com/en-us/download/details.aspx?id=49982

4 Downloading and installing MultiOne and the
documentation package

A zip-file can be downloaded from www.philips.com/MultiOne. This zip-file contains
the following files:

e Philips MultiOne.exe (executable/installer)

e Philips MultiOne Workflow.exe (executable/installer)
e GettingStarted.pdf (document)

e UserManual.pdf (document)

e RELEASE_NOTES.txt (document)

The MultiOne installation file is the installer for the full version of MultiOne. This
document applies to this version of the software.

The MultiOne Workflow installation file is the version of MultiOne which is meant to
be used in a production environment.

Note! Make sure a User Software Key is present before installing. If you wish to
install without a User Software Key, installation is possible, but you cannot work
with MultiOne.

To install the software, launch the installer for the desired version and follow the
instructions on your screen.
The installation wizard will guide you through the process of installing the software

and will ask you where the software needs to be installed. At the end, it will give you
the option to immediately start MultiOne.


http://www.philips.com/MultiOne

5 Attention points

5.1 General

Before starting MultiOne, make sure that the correct interface (USB2DAL],
USB2ZigBee or SimpleSet®) has been connected to your computer.

When upgrading the Windows Operating System, make sure the connection settings
are correct when using MultiOne again.

When starting multiple instances of MultiOne for parallel configuring, make sure
every instance of MultiOne uses another interface. The unique id of an interface is
shown in the Connection Settings window where the interface port is selected. Also,
for the currently selected interface the unique id can be found in the About box and
in the tooltip of the connection status indicator in the status bar at the bottom-right
part of MultiOne.

5.2 DALI

Lighting applications with DALI devices can be seriously affected by the
presence/absence of the DALI short address. Make sure the DALI short address is as
you expect, after finishing working with MultiOne.

5.3 SimpleSet® interface

For SimpleSet® there are three interfaces which can be used for communication (see
§6.3): the Philips LCN9600 (Engineering interface, basic use only), LCN9610, LCN9620
or LCN9630 (Under investigation) MultiOne interface SimpleSet®.
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6 The MultiOne interfaces

6.1 DALI

The Philips LCN8600 MultiOne interface USB2DALI (USB2DALI interface) is the
interface between the PC and the DALI devices. It has a mini- USB input connector
and two parallel DALI output connectors. The USB2DALI interface status is indicated
by three LED's located near the mini-USB connector.

The USB2DALI interface is supplied with a USB cable that can supply the DALI
network with up to 220mA. It is advised to only use the supplied cable, in order to
assure correct functioning of the USB2DALI interface.

e Safety: Class II, double insulated
e DALI open circuit voltage (when power supply enabled): 15V

mini-USB input connector

PHILIPS

DALI PC Tool USB Interface
LCNB600/00 DA B
—_— —_— — - DA+
i 9137 003 467 LS (s
° B Made in The Netherlands NGH =———|®
(Ve 0.5.15C DA D
i P 1203 =
2 DARIE
5

UREIIIN moms) > 7 €

Status LEDs: Double DALI
e DALI power supply enabled output
e DALI active connector
e Power

11



6.2 ZigBee

The Philips LCN8650 MultiOne interface USB2ZigBee (USB2ZigBee interface) is an
USB dongle which interfaces between the PC and the ZigBee devices.

6.3 SimpleSet®

The Philips LCN9600 (Engineering interface, basic use only), LCN9610, LCN9620 and
LCN9630 (Under investigation) MultiOne interface SimpleSet® are USB devices which
interface between the PC and the SimpleSet® devices:

Philips LCN9600 Philips LCN9610 Philips LCN9620

(Engineering interface, basic use only)

Philips LCN9630

(Under investigation)

12



7  Starting MultiOne

Before starting MultiOne, make sure that the correct interface (USB2DALI,

USB2ZigBee or SimpleSet®) has been connected to your computer.

7.1 Activating MultiOne

When starting MultiOne for the first time, the first window that appears is the
MultiOne user software key information. Here you can activate your copy of

MultiOne with your own user software key.

Note! MultiOne must be connected to the internet upon first usage in order to

activate.
put
MultiCne user software key information u
Activation status: Mot activated MultiOne profile: Engineering
Key status: Mot activated Error code: 4

Activate...

Proxy settings

User zoftware key details: Supported features:

e

Use the Activate... button to continue activation.

Use the Proxy settings button to enter the proxy credentials if this is required for

your infrastructure. An example of the information that can be entered can be found

in chapter Proxy.

Use the Help button to show the User Manual.

13



Select Activate MultiOne online now and follow the instructions.
i -

&, LE’)&. TurboActivate

Activate MultiOne now

Your activation period has expired and MultiOne is no longer working. To use your software
you must activate this copy of MultiOne,

2 Activate MultiOne online now

= Buy a new product key online

= Retype your product key

= Other options...

What is activation?
Read the privacy statement online

Cancel

A

The other items on this window are less relevant. For completeness:

Select Buy a new product key online brings you to www.philips.com/MultiOne.

Actually buying keys online is not supported.

Once you have activated MultiOne with a user software key, you can select Retype
your product key to switch to a different user software key.

The other items shown on the dialog are not supported.

If all goes well the activation is successful and the MultiOne user software key
information screen should show the correct details and supported features
corresponding to the user software key.

14


http://www.philips.com/MultiOne

-
MultiCne user software key information u

Activation status: Activated Multione profile: Engineering

Key status: 0K

De-activate... Proxy settings

Refresh status

User software key details: Supported features:

Prafile | Engineering 1-10% min dim lewvel i
Key T I N ActiLume

12ZNC (913700362103 ActiLume wired

ActiLume wireless

Active Cooling

IR T S I (SN T (0 S W W

Start MultOne

MultiOne is now ready for use!
Use the Refresh status button to refresh the license key status.

Note! Not all functionality described in this document applies to all MultiOne user
software keys. For instance, some device features might not be available, or they
might only be partially configurable.



7.2 Application mode selector

Once the activation process is done and when starting MultiOne, the first window
that appears is the Application Mode Selector. Here, you can choose an application
mode, based on the tasks you would like to perform. The application window also has
links to the documentation.

MultiOne S |

Application mode Recent documents
E an

. Commands

. Features
. Query

. Diagnostics
. Scheduler

. Data containers

. Sniffer

. Single device programming

One of the modes is Single device programming. This mode simplifies some parts
of the device configuration workflow when only one device has been connected.
Single device programming is discussed in detail in chapter 12.6.

If you know that you will mostly perform the same tasks in the future, you can select
Remember my choice and then click the appropriate application mode. MultiOne
will record your choice and The Application Mode Selector will not appear again the
next time MultiOne is started.

You can always go back to the Application Mode Selector by selecting View -
Application Mode Selector from the main application window.

16



8 Selecting the interface

After the Application Mode Selector you must select the interface (USB2DALI,
USB2ZigBee, Ethernet or SimpleSet®) to work with.

8.1 Interface Auto detection

Interface can be automatically detected in case of DALI and SimpleSet®.

On first start MultiOne will detect whether DALI or SimpleSet® interfaces are
connected to your PC or laptop.

e When only one interface is connected this one will be automatically chosen.
e Otherwise the Connection Settings window will appear.

Whenever MultiOne is started again and a previously selected interface is not
connected anymore the following selection or action will take place:

e When only one interface is connected (independent of the type of interface)
this one will be automatically chosen.

e When two interfaces are connected and one of them is of the same type as the
previously selected interface this interface is automatically selected.

e Otherwise the Connection Settings window will appear.

Connecting multiple similar SimpleSet® interfaces is currently only supported when
using a LCN9610, LCN9620 or LCN9630 interface.

Notice! Whenever MultiOne is started again, if the previously selected interface is not
either Dali or SimpleSet® the auto detection will not work and MultiOne will start with
the previously selected interface.

8.2 Interface Manual selection

First select the protocol: DALI, ZigBee, Art-Net or SimpleSet®, when needed also
indicate the selected interface and port or reader (in case of SimpleSet®).

17



Connection settings @
® DALl O ZigBee O Art-Met O SimpleSet
Interface selection
Selected interface MutiOne DALI interface -
Selected port 17A717294007 -
| =n

This protocol can always be changed later, by going to the Tools > Connection
settings.

Notice! For DALI and SimpleSet® the unique id of the interface is shown at the
port/reader selection. This, to be able to identify which interface is used by which
MultiOne instance (when configuring devices in parallel using multiple instances of
MultiOne).

When a selected interface contains an outdated firmware version, MultiOne will show
a message that it is unable to connect to the selected interface:

Connection settings @

O DALl O ZigBee O Art-Net ® SimpleSet

Unable to connect

MultiOne can't connect to the selected interface because its firmware version
(02.03.00) is outdated.

| ==
8.2.1 Art-Net

For the Art-Net protocol the delay time between sending frames is shown in the
dialog. This delay time is set to 28ms and cannot be changed.

Selected interface [ArtNet (1045.67.2) -

RDM delay time (ms) 28 =

18



Note! Please make sure that the selected interface corresponds to the connected Art-
Net network and has the correct IP address (for example use the 10.45.67.2 interface
to connect with a Luminex network).

19



9 Working with the Philips LCN8600 MultiOne interface
USB2DALI

Before using MultiOne with the USB2DALI interface make sure that all devices that
need to be commissioned are connected to the mains and the DALI network. Finally
the DALI network must be connected to one of the DALI connectors of the USB2DALI
interface.

9.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

File  Actions View

®© O @

MNetwork Device features | 5,000

Traceability ~ Scheduler  Query  Diagnostics
No device has been selected or the selected device doesn't support any features.

Use Network to select a device.

Scan network

Properties 1 X | Logging

Broadcast

A more thorough explanation on how to communicate with devices can be found in
chapters 12.2,12.11, 12.12, 12.12 and 12.3 of this manual.

9.2 Managing the DALI network

The Network panel is used to manage the connected DALI network. A number of
tasks can be performed in the Network, each of which is detailed below.

9.2.1 Identifying devices

When starting MultiOne, the DALI devices connected to the USB2DALI interface are
not automatically identified. There are two methods for identifying the devices with
corresponding buttons in the Network on the left-hand side of the application
window: Scan network and Commission.

20



[ Network 2 x

Metwork (‘:nqn

i... User-defined aroups

Scan network Commission

9.2.1.1 Scan network
There are two ways to scan a network: by short address or by random address. You
can choose which method to use by going to Tools->Preferences->DALI scanning.

The key differences between scanning by short address and scanning by random
address are the following:

e Scanning by short address will not change the random addresses of the
connected devices. You should use this method if random addresses should
not be affected. Additional user input might be required to find all connected
devices (see below).

e Scanning by random address will change the random addresses of all
connected devices. Any devices that do not have a short address yet will be
assigned one automatically. Any devices that share the same short address will
be automatically assigned (new) unique short addresses. This method is most
likely to find all connected devices without user intervention.

Scan by short address. This method queries all short addresses without changing
anything in the configurations of the connected devices. If all connected devices have
a unique short address, this method will be able to find all devices. If, however, some
devices share the same short address, or if there are devices without a short address
(uncommissioned devices), additional decisions need to be made.

The following situations can occur while scanning a network by short address:

e There are uncommissioned devices. You will see the following dialog:

Once or more uncommissioned devices were found. Do you want to commission
these devices?

Warning: by clicking yes, the random address of all devices in the network will be
changed.

21



By clicking Yes, the uncommissioned devices will be commissioned. As a side
effect, the random addresses of all connected devices will be changed.

By clicking No, no additional actions will be done and the Network will not
display all devices.

There are devices with the same short address. You will see the following
dialog:

ouptcne ot e D =

Multiple devices were found that share the same short address. Do you want to
recommission these devices?

Warning: by clicking yes, the random address of all devices in the network will be
changed.

By clicking Yes, the devices that have the same short address will be
recommissioned. As a side effect, the random addresses of all connected
devices will be changed.

By clicking No, no additional actions will be done and the Network will not
display all devices. Errors are likely to occur, indicated by a warning icon next
to the name of the device(s).

There are uncommissioned devices AND devices with the same short address.
You will see the following dialog:

| Uncommissioned devices and duplicate short addresses @

The following situation occurred:

- One or more uncommissioned devices were found.
- Multiple devices were found that share the same short address.

How do you want to continue? Click cancel to accept the network in
its current state.

0 Commission the uncommissioned devices and recommission the
devices that share the same short address

O Commission the uncommissioned devices only

Warning: by clicking continue, the random addresses of all devices

in the network will be changed.

By choosing the first option, all uncommissioned devices will be
commissioned, and all devices with the same short address will be
recommissioned. By choosing the second option, only the uncommissioned
devices will be recommissioned. By clicking Cancel, no additional actions will
be done and the Network will not display all devices. Errors are likely to occur,
indicated by a warning icon next to the name of the device(s).
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Scan by random address. This method re-initializes the random addresses of all
connected devices. If there are any uncommissioned devices, or devices that have the
same short address, these devices will automatically be (re)commissioned.

9.2.1.2 Commissioning

All devices are given a new unique short address, starting at 0. Be aware that existing
short addresses are erased and new short addresses are re-assigned to all connected
devices. This procedure ensures that all devices have a short address and that there
are no duplicate short addresses.

After commissioning or scanning the network, the list of identified devices is shown in
the Network.

9.2.2 Selecting devices for communication

After having commissioned or scanned the network, the Network shows all devices
present in the DALI network.

Network

=)- All devices

0: ¥itanium Outdoor 40W. 7P+ VIEDT
L. T Xitanium 36W 0.3-1A 54V TD 230V 1.3
i... User-defined groups

Scan network Commission

By clicking a device you will make that particular device the active one, meaning that
all commands will be sent to this device only, and will be ignored by all other devices.
Besides selecting a single device for communication, it is also possible to
communicate with groups of devices. The options are:

e All devices in the network. Select All devices. All commands will now be sent

as broadcast commands. Note that unidentified but connected DALI devices
will also respond to commands.
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e All user-defined groups. Select User-defined groups. All commands will now
be sent to devices that belong to a user-defined group. User defined groups
are explained in the section 9.2.3.

e A specific user-defined group. Expand User-defined groups and select the
desired user-defined group. All commands will now be sent to devices that
belong to this specific user-defined group.

9.2.3 Managing user-defined groups

Using the Network, devices can temporarily be grouped into user-defined groups.
The purpose of user-defined groups is that they facilitate easy clustering so that a
number of devices can be addressed simultaneously.

The user-defined groups are lost when MultiOne is closed.

A new user-defined group can be created by right-clicking User-defined groups and
selecting Add new group.

- All devices

5---dd new group “

Alternatively choose Actions - Add user-defined group. A new group is created
with a default name. To add a device to a user-defined group, right-click the device,
select Add to custom group and select one of the available user-defined groups.
Alternatively, the device can be dragged onto the desired user-defined group to add
it to that group.

To immediately add a device to a new user-defined group, right-click a device and
select Add to user-defined group and select Add new group.

Network

=- Ml devices

I 0: itanium 17\ 0.3-1A 24V TD/ls 2 e

... User-defined groups Identify
| Add to user-defined group  » Add new group

Set short address...
Reset short address

The user-defined group will be created and the selected device will be added to the
newly created user-defined group.

To rename a user-defined group, right-click the group and select Rename. This will
set the user-defined group to edit mode so that the new name can be entered.
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' Metwork o X
MNetwork [RUEGTS

- Ml devices
- User-defined groups

Remove

| Rename

To remove a device from a user-defined group, right-click the device in the group
and select Remove.

To remove an entire user-defined group (including its devices), right-click the group
and select Remove.

MNetwork o x
Network  [E[TS

- All devices
= User-defined groups

My oot

Note! The number of devices in a user-defined group is limited to 64.

9.2.4 Managing groups

Once all the devices in the DALI network are commissioned, i.e. have a unique short
address, it is possible to work with DALI groups.

Select the Groups tab and click Scan groups. After having scanned the network for
groups, the Groups tab shows all the DALI groups and the found devices for every

group.
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Network 1 x

II::' Groups

=} Un-grouped devices
i 1 ¥itanium Outdoor 40W. 7P+ VIED
= Group 0
L 12 Mitanium 36W 0.3-1A 54V TD 230V 1.3
. Group 1
. Group 2
. Group 3
- Group 4
.. Group 5
.. Group 6
.. Group 7
.. Group 8
. Group 9
.. Group 10
... Group 11
.. Group 12
.. Group 13
.. Group 14
.. Group 15

Scan groups

DALI groups are much more comprehensive than user-defined groups. The important
difference is that with DALI grouping information is stored in the devices themselves.
Therefore, DALI grouping is more permanent than user-defined grouping.

By clicking on a device you will make that particular device the active one, meaning
that all actions will be performed on this device only, and will be ignored by all other
devices.

The options are:

e With a right-click on an un-grouped device you can:
o Identify the device
o Add to, add the device to one group
o Configure..., add device to multiple groups

Device configuration @

Selected groups for device LED
925000712803:

»

® Group 0 il
® Group 1
O Group 2
[ Group 3
[ Group 4
O Group 5
[ Group 6 | 4
O Group 7

O Group 8

| [ Group & |
[1 Groun 10

m
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e With a right-click on a device in a group you can:

Identify the device

o Add to, add the device to one other group

o Configure..., add/remove device to/from multiple groups
o Remove, remove device from current group

O

Network 4 X Device features

=8 Un-grouped devices - Dynadimm
| L tanium 25W 0.3-1A 36 | | Summary !
& Group 0 Dynadimmer Enabled:
.. 0: Dynavision Prog R2.2 Time bast
- Group 1 o _
Switch Mid point
E| Group 2 Identify . -
¢ . D: Dynavision Add to selection | Time
E| G_I‘OLID 3 ) Dim 00:00
© L.0: Dynavision ST 06:00
i Group 4 Remaove -
.. Group 5 —_ 13 vy Meter

Scan groups ALD

Besides selecting a single device for communication, it is also possible to
communicate with a group of devices.

The options are:

e With a right-click on a group you can:
o Identify the devices in the group
o Configure..., add/remove multiple devices to/from the group
o Clear group, remove the devices from the group



Network o x
Groups

i~ Un-grouped devices -

Identify

Configure...

Clear group

Scan groups

Note! The number of devices in a DALI group is limited to 64.



10 Working with the Philips LCN8650 MultiOne interface
USB2ZigBee

10.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

No device has been selected or the selected device doesn't support any features.

Use Network to select a device.

B Scan area to find devices

Connect to network

10.2 Connecting to a ZigBee network

The Network panel is used to manage a connected ZigBee network. A number of
tasks can be performed in the Network panel, each of which is detailed below.

Network 1 x
Network
(= Network: D7BF13BD5CTEE1CD

10.2.1Identifying devices
The ZigBee devices and networks in the area of the USB2ZigBee interface are not

automatically known.
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To find devices and networks in the area click Connect to network: MultiOne scans
for an open network in the area and connects to the network. After connecting has
finished, the network and the found devices are shown in the Network panel.

10.2.2 Selecting devices for communication

After having connected to the network, the Network panel shows all devices and the
network to which MultiOne is connected. By clicking on a device or network you will
make that particular device or network the active one, meaning that all actions will be
performed on this device or network only, and will be ignored by all other devices or
networks.

With a right click on a device you can:
o Identify the device

10.3 Advanced commissioning

To commission a ZigBee network, right click the Network panel and choose Enable
advanced commissioning.

Network  |SZoTES]
Use Network t

| Enable advanced commissicning

The Network panel switches to a different view making it possible to manage ZigBee
networks.

10.3.11dentifying devices

Click Scan area to scan for all the devices and network in the area of the USB2ZigBee
interface. After scan has finished the devices and networks in range of the interface
are shown in the Network panel.

10.3.2 Managing networks
The options are:

e With a right-click on an unassigned device you can:
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o Add to, move the device to an existing network or move the device to a
new network
e With a right-click on a device in a network you can:
o Add to, move the device to an existing network or move the device to a
new network
o Reset, from network, the device will become unassigned. If the network
becomes empty, the network will be removed
e With a right-click on a network you can:
o Query network, to find all devices in the network, including the devices
that are out of range of the USB2ZigBee interface
o Open network, to add more devices

10.3.3 Managing zones

Once you have scanned the area and found devices and networks in range, it is
possible to scan a specific network for zones. Select the Zones tab, select the
Network and click Scan zones. After having scanned the network, the Zones tab
shows the found devices and zones within the specified network.

[ [
Network: 98640 11C2A3FDOCE -
[
124B00 15 Actime v1.0
Zone SOFC
124B0001D: 9 Actiume v1.0
124B0001DEEE 18: Acthume v1.0

Scan zones

By clicking on a device or zone you will make that particular device or zone the active
one, meaning that all actions will be performed on this device or zone only, and will
be ignored by all other devices.

e With a right-click on an unassigned device you can:
o Identify the device
o Add to, move the device to an existing or new zone
e With a right-click on a device in a zone you can:
o Identify the device
o Add to, move the device to an another or new zone
o Configure..., move the device to another zone

31



Device configuration E‘

Selected zones for device Actilume:

® Zone 2100
O Zone E196

o | o |

o Remove, the device will become unassigned. If the zone becomes
empty, the zone will be removed

e With a right-click on a zone you can:
o Identify the zone
o Configure..., add/remove multiple devices to/from the zone. If other
zones become empty, they will be removed

Zone 2100 (=]

Select devices for Zone 2100:

[® 124B0001D8E62B: Actilume v1.0
[® 124B0001D79342: Actilume v1.0

Coc Lo

o Remove zone, the zone will be removed and the devices will become
unassigned



11 Working with the Philips MultiOne SimpleSet®
interface(s)

11.1 The main application window

If in the Application Mode Selector screen All is selected as application mode, the
program will start as follows:

No device has been selected or the selected device doesn't support any features.

Use Network to select a device.

B o device detected

Logging
Timestamp Description

Scan for device

SimpleSet @

11.2 Scanning a SimpleSet® device

The Network panel is used to manage the scanned SimpleSet® devices. A number of
tasks can be performed in the Network panel, each of which is detailed below.

11.2.1Identifying devices

The SimpleSet® device near the SimpleSet® interface is not automatically known by
MultiOne. To get the device click Scan for device: a pop-up will appear indicating
the device must touch the interface.

Touch and hold the device close to the SimpleSet® interface until the scan has
completed. The scanned device will be shown in the Network panel.
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11.2.2 Auto read
After a device gets selected all features are shown on the Features tab and auto rea

d

gets activated. Auto read automatically start reading the configuration of all features.

Progress is shown as described in chapter 12.2

11.3 Selecting devices for communication

After having scanned the SimpleSet® device, the Network panel shows the device. By
clicking on a device you will make that particular device the active one, meaning that

all actions will be performed on this device only, and will be ignored by all other
devices.

11.4 Starting communication

In order to communicate with a SimpleSet® device, the device has to touch the
SimpleSet® interface. Before starting the communication MultiOne will show a pop-
up when the device is not near the SimpleSet® interface. This pop-up waits until the
device and the SimpleSet® interface touch, or disappears after 20 seconds. After
touching the action will be executed. Touch and hold the device close to the
SimpleSet® interface until all communication has finished.

Please touch...

Waiting for the device
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12 Working with MultiOne

12.1 Viewing device properties

Whenever a device is selected in Network, the Properties display a number of
details for the selected device.

Selected Xtanium 40W 1.1A B4V DALI SR INT
Version 0.1

12MC 929000724613

Device type LED

Firmware revision 1082

Device identifier E00258D265175078

12.2 Communicating with a device

Initiating communication with a device is done by first selecting the device (left-click
the device in Network) and then clicking Read, Write or Reset on the toolbar.

File  Acti~nc View Tools Help

‘oRead @ wiite @ Reset ]. -
e —— ————

When the Commands tab or the Scheduler tab is active, these buttons are
unavailable. When the Query tab is active, all queries are executed when clicking
Read. When the Diagnostics tab is active, all diagnostics information is read (if
available in the selected device) when clicking Read. When the Device features tab is
active, the Read and Write actions are available. The Reset action is only available on
the Device features tab when the selected device has 1 or more features that are
resettable. The Reset action will set a feature to its factory defaults.

Reading, writing and resetting will always take a few seconds. Operation progress is
shown on the status bar of the main application window. On the Device features tab,
per-feature progress is shown on each of the feature selection tabs. When all
information has been successfully read or written, a green tick mark will appear and
the text Status: OK is shown. If anything goes wrong, a red icon and the text Status:
failed is shown. When on the Device features tab, point your mouse to each status
icon to see a more detailed description of the communication result.

Apart from using Read and Write on the toolbar, you can directly send DALI
commands. This can be done on the Commands tab and the Scheduler tab.
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In the Preferences window it is possible to enable extra verification when writing (see
chapter 12.19).

12.3 Configuring device features

You can configure all features that are supported by a specific Philips device. For any
device selected in the Network, the Device features tab displays the set of device
features that corresponds to this device. Upon selecting another device, the Device
features tab will be updated as well. This mechanism ensures that only the features
supported by the selected device can be configured.

The Device features tab has a panel with a column of tabs on the left-hand side.
Each feature has its own tab. For most devices a Summary tab is available as well.

AmpDim
Summa
2 [ Enable
Dynadimmer
Values
CLO 100
_ . Low % 60
Li h a0
_ Low V 195

Lamp selection

- High % 100 80
AmpDim

High v 230 70

ALOD

60

Energy Meter
50

Light level (%)

40

30

20

i0

70 S0 110 130 150 170 1%0 210 230 250 27V0

Mains (V)

To make sure that the feature information in the Device features tab corresponds to
the selected device, click Read on the toolbar.

File Actions View Tools Help

(@ Read P Write @ Reset | =
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Note that some features might be OEM Readout-protected. OEM Readout-protected
features are indicated by a padlock icon in the Read feature configuration window.

Read feature configuration @

Flease indicate which feature configurations need to be read.

Features

% (De)select all

% DALI PowerSupply

% Adjustable Output Current
% & Energy Meter

@ Indicates that the feature is OEM Readout-protected.

If an OEM Readout-protected feature is read, a dialog will appear asking for an access
level and a password.

' Enter password @

Access level: D

Password: | | | | | | | |

I

After providing a correct access level and password, and clicking OK, the OEM
Readout-protected features will be read. By clicking Cancel none of the selected
features will be read. If an incorrect access level and/or password were provided, the
OEM Readout-protected features will receive a status icon indicating failure (see
below).

To make sure that the feature information is stored in the selected device, click Write
on the toolbar. If you want to reset certain features to its default settings, click Reset
on the toolbar. Be aware that you need to click the Read button afterwards to reload
the reset values.

Note also that some features might be OEM Write-protected. OEM Write-protected

features are also indicated by a padlock icon in the Write feature configuration
window.
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Write feature configuration

Write feature configuration

Flease indicate which feature configurations need to be written.

Features

Flease indicate which feature configurations need to be written.

Features

% (De)select all (De)select all
% DALI Power Supply DALI Power Supply
% Adjustable Light Output Adjustable Light Qutput

® @ OWP settings (ALO Min) 8 OWP settings (ALO Min)
¥ @ Adjustable Output Current 8 adjustable Output Current
X Energy Meter Energy Meter
® @ OEM Write Protection ® @ OEM Write Protection

The device already has an QWP password B Indicates that the feature is OEM Write-protected.

i i When clicking Write, the following actions will be performed:
@ Indicates that the feature can be OEM Write-protected.
- Write feature configuration

When clicking Write, the following actions will be performed: - Verify feature configuration

- Write feature configuration

! . C You can adjust this behavior in the preferences.
- Verify feature configuration

You can adjust this behavior in the preferences.

Also note that you must select a check box to indicate that the device already has an
OWP password configured. MultiOne does not know this, because the configuration
of a device is not always read before a Write action takes place. When the check box
is selected and the Write button is clicked, a dialog will appear asking for a password.
When the OWP configuration was already read, MultiOne knows the current OWP
configuration and the check box will not be shown. In that way, MultiOne will show
the password dialog only in case if OWP is enabled in the device and a write
protected feature is selected.

Enter current password @

Password: l:l l:l l:l l:l

After providing a correct password and clicking OK, the OEM Write-protected
features will be written. By clicking Cancel none of the selected features will be
written. If an incorrect password was provided, the OEM Write-protected features will
receive a status icon indicating failure (see below).

For Read, Write and Reset actions, status icons will be shown when a feature is being
read or written. There are four different colors used for the icons: red, orange, green
and grey.

Red means that the read or write action failed. The green icon indicates that reading
or writing was successful and that all the data was sent to the driver. This does not
mean that all data is actually received (see Write and Verify in chapter 12.18.1). The
grey icon is used to display that the read or write action is pending for the specific
feature. An orange icon indicates that the last write action for the feature was not
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successful and that the feature might not be configured correctly; the orange
indicator is only applicable for SimpleSet devices.

Summary Summary General Summary

-:::- Dynadimmer -:::- Dynadimmer -:::- Mode 1 -:::- DALI PSU

@) cLo @ cLo () Mode 2 () pynadimmer

@ LineSwitch @) LineSwitch (@) Mode 3 @ aLo

© Lampselec... ® Lamp selec... @ Mode 4 @ aoc

© AmpDim @ AmpDim @ Mode s @ cLo

(1) ALD (¥) ALO @ Modes @ LsI

»r Energy Meter 4; Energy Meter Q Mode 7 ':::' EOL
Read Write Reset Read

In the following sections you will find an overview of all supported device features in
alphabetical order. Features typically belong to one or two product groups (LED, HID
or FLUO), but this does not mean that every device belonging to a certain product

group will automatically support all of its features listed here. For an overview of
supported device features see Supported features.
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12.3.10-10V / 1-10V

Product group

CONTROL
Curve selection: [Userspeciﬂed -
User specified curve

Dim level [%] 0-10V / 1-10V

1 2 o =
7 ] =
13 = 1.9 %
19 = 23 =
25 = [2.8 =
31 4 32 =
a7 = |36 =
42 = 4.0 =
47 = 4.3 =
52 =) |47 =
57 = |5.0 =
62 = 54 =
&7 = |27 %
72 = 6.1 =
77 =/ 6.4 =
83 L] =
89 = |73 =
95 = |77 %
100 = (8.0 =

Description

The 0-10V interface requires special configuration to match the 0-10V (or 1-10V)
dimming curves of the connected drivers. The SR Bridge needs to correctly and
accurately translate the DALI arc power commands to the correct 0-10V dimming
voltages for the connected drivers such that the appropriate LED driver output
current is achieved. This feature is used to configure the dimming curve by either
selecting a predefined fixed curve or specifying a curve manually.

Usage

Use the drop down box to select the 0-10V (or 1-10V) curve that should be used for
the SR Bridge. There are four fixed curves (1-10V curved, 1-8V linear, 1-9V linear and
1-8V logarithmic) selectable and there is a possibility to select the User specified
option.
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Selecting the 'User specified’ ZTV curve makes the User specified curve properties
visible which can be used to construct a specific 0-10V (or 1-10V) curve. Both the Dim
level and 0-10V / 1-10V values can be changed to create a specific 0-10V (or 1-10V)
curve.

12.3.21-10V
Product group
LED

X Enahle

. o A

Curve selection: 1-8V linear v]

Description
Use this feature to set the minimum dim level when using 1-10V.

Usage
e Use the slider or the text field to select a value. The value represents the light
level.
e Use the drop down box to select the wanted curve selection (1-8V linear, 1-9V
linear, 1-10V curved or 1-8V logarithmic). The curve selection is device
dependent.
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12.3.3 ActiLume General

Product group/family

CONTROL/ActiLume DALI

Configuration:

Mode:

IR channel:

Region:

Occupancy sharing:

¥ Local daylight sensing
[* Local presence sensing

Presence sensor sensitiviby:

Night mode
Hold time:

Background level:

Prolong time:

BMS

Light =ensor reference point:

[J DALI occupancy reporting

| Parallel link

[1

(A

|EU

[Mode based

| High

G600 I

[5 minutes

[20%

[15 minutes

O Send HVYAC/sunblind messages to BMS

Description

Use this feature to configure general ActiLume settings.

Usage

Use the various drop down boxes, check boxes and text fields to make a

configuration.

Please refer to the ActiLume DALI gen2 Application Guide for further details.
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Product group/family
CONTROL/ActiLume Wireless

[0 100 hour burn-in

= m
L=l | [y
=
o
&

Mode: [‘] v]
IR channel: [H v]
Region:

Light =ensar reference point: 3¢
Reference point correction factor: 8
Occupancy mode override: [F‘ath of egress ']

Description

Use this feature to configure general ActiLume settings.

Usage

Use the various drop down boxes, check boxes and text fields to make a

configuration.

Please refer to the ActiLume Wireless Application Guide for further details.

12.3.4 ActiLume Mode
Product group/family
CONTROL/ActiLume DALI

Hold time: 15 half min
Prolong time: l:l min O Infinite
Smart time: min
Grace time: = [® Fade during grace period
Light status on power up:
Retention time: 15 »| min
Background level: %
Dwell time: l:l s
Light sensor reference point: 210 I
Group 1 Group 2 Group 3 Group 4
Cccupancy mode: [Moon / auto off v] [Mo on / auto off [Mo on / auto off [Mo on / auto off v] [Auto on / auto off
Daylight dependent override: [ O O O
Daylight dependent switching: = ] ] ]
Daylight dependent regulation: = [ [ ]
Daylight regulation offset: % 0 Ya
Switch on level prior to DDR: % %a 100 100 %
Mode based linking
Reaction to mede: 1 [Ignore v] 5 llgnore 9 [Ignore 13 [\gnore
2 [Ignore v] [ [Ignore 10 [Ignore 14 [\gnore
3 [Ignore v] 7 [Ignore 11 [Ignore 15 [\gnore
4 [Ignore v] 8 llgnore 12 [Ignore 16 [\gnore
Group based linking
Base group: Local occupancy

II

Secondary group: Local occupancy




Description
Use this feature to configure ActiLume settings that apply to the system’s modes. For

ActiLume DALI gen2, up to 16 modes are shown, each of which has its own feature
tab on the left-hand side. Use the ActiLume Mode feature to configure settings for
each individual mode.

Usage
Use the various drop down boxes, check boxes and text fields to make a

configuration. Click the Reset to factory defaults button to reset the current mode
to the factory defaults.

Please refer to the ActiLume DALI gen2 Application Guide for further details.

Product group/family
CONTROL/ActiLume Wireless

Held time: |3D | half min
Frolong time: |D | min Infinite
Light status on power up: [Ugl‘rls off "J
Background level: |1El | L
Occupancy mode: [Mu on / auto off 'J
Light =ensor reference point: |210 | I
Description

Use this feature to configure ActiLume settings for that apply to the system’s modes.
For ActiLume Wireless, up to 32 modes are shown, each of which has its own feature
tab on the left-hand side. Use the ActiLume Mode feature to configure settings for
each individual mode.

Usage
Use the various drop down boxes, check boxes and text fields to make a

configuration.

Please refer to the ActiLume Wireless Application Guide for further details.
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12.3.5 ActiLume Scene
Product group/family
CONTROL/ActiLume DALI

Group 1 Group 2 Group 3 Group 4 Group 5

Dim behavior:  |Manual dim level - Manual dim level - Manual dim level Manual dim level Manual dim level -

Dim level: [so | = [s0 | = [s0 | = [s0 | = [s0 | =

Description

Use this feature to configure ActiLume settings that apply to the system'’s scenes. For
ActiLume DALI gen2, 5 scenes are shown, each of which has its own feature tab on
the left-hand side. Use the ActiLume Scene feature to configure settings for each
individual scene.

Usage
Use the various check boxes and text fields to make a configuration.

Please refer to the ActiLume DALI gen2 Application Guide for further details.

12.3.6 Active Cooling

Product group
LED

Values

Fan level (%)

a 10 20 30 40 50 60 70 80 S0 100 110 120 130 140

Temperature (°C)

150

Description
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Use this feature to control the fan of the LED module and minimize audible noise
from the active cooling unit. The driver increases the fan output level (and so the
speed of the fan) when temperature of the LED module becomes too high. When the
fan output level increases the temperature of the LED module should be reduced.

The customer can specify the temperature limits to make sure the fan output level is
kept as low as possible and will only increase when needed so the audible noise is
reduced.

Usage
Drag the points or the lines in the resulting graph to adjust the configuration.
Alternatively, use the table to enter values directly.

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.

12.3.7 Adjustable Light Output

Product group
HID
% Enable
ALO: { ® B
ALC min: [ [ ] )| %
Description

Use the Adjustable Light Output (ALO) feature to regulate the light output to a
desired optimum value. You can create a “virtual lamp” with output different than
what the standard wattages offer.

Usage

Select the Enable check box to use this feature. Use the slider or the text field to
select an ALO value. The value represents the light level. The ALO min value (not
available for all devices) can be used to set the lowest possible ALO value.
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12.3.8 Adjustable Output Current

Product group
LED

®| External Rset

( ] ) 650 més
Description

Use this Adjustable Output Current (AOC) feature to adjust the output current to a
desired optimum value. You can create a “virtual lamp” with output different than
what the standard wattages offer.

Usage
The current can be set in two ways:

o Select the External Rset check box: Adjustment of the output current is not
configured using MultiOne, but the value of an external resistor adjusts the
output current

OR

e Use the slider or the text field to select a value. The value represents the

nominal output current

12.3.9 Adjustable Startup Time

Product group
LED

L ] )] I'IUDU s
Description

At power on, the fast fade-up of light can be unpleasant in certain applications. To
avoid such a situation, the device fade-up time at startup can be adjusted.

Usage

Use the slider or the text field to select a value. The value represents the start fade-up

time in milliseconds.
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12.3.10 AmpDim
Product group
HID, LED

[® Enable

Values

100
Low % 60

Low V 195 30

High % 100 80

High v 230 70

60

50

Light level (%)

40

30

20

10

70 90 110 130 150 1¥0 150 210 230 250 270

Mains (V)

Description
Use this feature to adjust the light output of a lamp by adjusting the mains voltage of
the device.

Usage

Select the Enable* check box to use this feature (note that LED devices do not have
this check box). Drag the points or the lines in the graph to create the desired
configuration. Alternatively, use the table to directly enter values.

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.11 Coded Light On and Off
Product group
LED

‘ [ Enable ‘

Description
Use this feature to enable/disable the Coded Light feature in the device.
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Usage

Select the Enable check box to use this feature.

12.3.12 Coded Mains

Product group
Enabled

% Qverride

Fade time: 7 ~| 5,7

Fast fade time: 27 675 ms

Fallback detection time: x ] )] min

Power on level: 4 [ ] %

Scenes

Scene 0/ fpp 2 Keep last defined dim-level

Fallback: = P ’

Scene 1: 0 = Scene 5: 50 |5 Scene 9: 85 [

Scene 2: 1 = Scene 6: B0 |5 Scene 10: (30 £

Scene 3: (10 2 Scene 7: |72 5 Scene 11: (35 2

Scene 4: E Scene 8: 80 1 Scene 12: |100 £
Description

Use this feature to configure the coded mains settings that are used when a coded
mains command is received from a transmitter regarding the requested dimming
scene for the driver.

Usage

Select the Enable* check box to use this feature and enable the coded mains
interface on the driver. This feature has the following parameters:

Override: If the check box is selected, that means the dim level can be
overridden by other dimming interfaces.

Fade time: Used to indicate how long it takes to perform a fade when
switching scenes. The corresponding timings can be found in the driver
specifications, and the corresponding time for the selected Fade time is also
displayed next to the selection. In case Fade time is O, the Fast fade time
setting is used.

Fast fade time: Used to indicate how long it takes to perform a fade when
switching scenes. The corresponding timings can be found in the driver
specifications, and the corresponding time for the selected Fast fade time is
also displayed next to the selection. In case both Fade time and Fast fade
time are 0, it means that there is no fade and the transition between scenes
takes place immediately.
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e Fallback detection time: Indicates the time after a driver power cycle that is
used to wait for a valid coded mains command. In case no valid command is
received within this time frame, the driver will switch to the fallback scene
(Scene 0).

e Power on level: The light level applied when the driver is powered and before
the first valid coded mains command is received.

e Scenes: Configurable dimming levels for a driver. A driver contains 13 scenes
which can be configured individually between 0 and 100%. Scene 0 is the
fallback scene which can also be configured as 'keep the last defined dim-
level'.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.13 Coded Mains Standalone Receiver

Product group
CONTROL
Control Qutput: Autodetect driver type
® DALI output
1-10V output
Description

Use this feature to configure the control output for the coded mains standalone
receiver.

Usage
Select one of the options to set the desired control output.

12.3.14 Constant Light Output
Product group
HID, LED

12.3.14.1 HID version

The HID version of Constant Light Output (CLO) has two check boxes. Select the
Enable check box to use the device’s built-in Constant Light Output profile. Select the
Reset check box to reset this feature, including resetting the lamp operating hours
parameters. This is useful when replacing the HID lamp.
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12.3.14.2 LED version
The Constant Light Output feature for LED devices will show the following window:

[* Enahle
Schedule
-1
Working| Power K
hours level
L] 40
#
7500 40 —
o
15000 |41 &
[ .
22500 42 g
(=]
30000 |44 e
37500 46 -
45000 49
52500 53
60000 57
0 5 10152025303540455055606570755058559095100031015
67500 61 .
& working hours x1000 (h)

When a newer version of CLO is present in the device, the following window will be

displayed:
[ Enable
Schedule
1 1=
Working Power 1~
hours level
o 40
8000 40
15000 41
22000 42 g
30000 44 =
38000 a6 %
45000 49 | %
52000 53 I *
60000 57
68000 61
75000 66
82000 71
90000 77
99000 83
108000 20 T a 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95 100 105 110 115
120000 100 ai Working hours x1000 (h)
Description

The lumen output of a LED module usually decreases over its lifetime. To
compensate, a schedule can be created that gradually increases the lamp’s power
level over time.
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Usage

Select the Enable check box to use this feature. Click the New button to create a
default schedule or click the Plus button to individually add scenes.

When creating a new schedule, in the dialog window that pops up you can either
select an empty schedule, a default schedule or a custom schedule.

New CLO schedule... = New CLO schedule... ™ =

Custom CLO schedule How does this work?

@ Empty schedule

I Maximum working hours 120 x1.000

Number of scenes 16
) Default schedule
Initial power level 40

Final power level 100

) Custom schedule...

When selecting a custom schedule, you have to enter a number of parameters that
will define the CLO schedule. These are:

¢ Maximum working hours: the largest number of working hours for which the
CLO schedule is defined. This corresponds to the maximum value of the
horizontal axis in the resulting CLO graph.

e Number of scenes: the number of scenes (bars in the graph, or in the newer
version the points in the graph) into which the total number of burning hours
is divided

o Initial power level: the power level that is the starting point at 0 burning
hours

o Final power level: the power level at the end of the defined lifetime (the value
given for maximum number of burning hours)

After clicking Finish a CLO schedule will be created using linear interpolation of the
provided values.

Drag the points or the lines in the resulting graph to adjust the configuration.
Alternatively, use the table to enter values directly. Single or multiple table rows can

be removed by clicking the Minus button.

Note! The reliable use of Constant Light Output requires extensive LED specification
assessment of life time behavior of LEDs.
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12.3.14.3 LED version (simplified)
The simplified Constant Light Output feature will show the following window:

%] Enable

Maximum working

hours: ‘ L] ) h

Initial power level: ( [ ] ] %
Description

The lumen output of a LED module usually decreases over its lifetime. To
compensate, a schedule can be created that gradually increases the lamp’s power
level over time. By configuring the Maximum working hours and the Initial power
level a linear schedule is defined which consists of 16 scenes. The first scene starts at
Oh and at the specified initial power level. The last scene starts at the specified
working hours and at 100% power level.

Usage

Select the Enable check box to use this feature. Use the Maximum working hours
slider to configure the moment in time where the LED module will use the final power
level.

Use the Initial power level slider to configure at which power level the LED module
will initially start.

Note! The reliable use of Constant Light Output requires extensive LED specification
assessment of life time behavior of LEDs.

12.3.15 Correlated Color Temperature
Product group

LED

ccT: (4000 |k
Description

The CCT value is the actual Correlated Color Temperature value of a Luminaire
device. In this way, the user can configure the requested light color of the Luminaire's
LED module.

Usage

Select the CCT value from the drop down box to change the Correlated Color
Temperature. This value is represented in Kelvin.
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12.3.16 Corridor Mode
Product group
FLUO, LED

% Enable

Dim level (%)

Mormal level: 4 » |254 (5= 100 %)
Background I— =10
" i [ ] 3 [170 (= 10 %)
Delay time: [ ] )] ID 5
Fade time: 4 [ ] ] |12 (32 5)
Prolong time: [ F ] j] IlSDD 5 Infinite
Activation l—
time: c L] ) |5s s
. .
Description

Corridor Mode feature depends on Touch and Dim feature. The Corridor Mode
feature adjusts the light to a defined level when a presence sensor detects a person.
Corridor Mode can only be activated when the device is in Touch and Dim mode.

Usage
Select the Enable check box to use this feature. It is not possible to activate the driver
via Touch and Dim, when this check box is not selected.

This feature has the following parameters:

¢ Normal level: Light level to be set when presence sensor detects activity

e Background level: Low light level to be set when no presence is detected
after the fade time

e Delay time: The time from the moment the sensor has switched off and the
moment the device will start to fade to background level

e Fade time: The time used to fade from normal level to background level

¢ Prolong time: When reaching background level, the time after which the
device will be switched off

e Activation time: The time during which a mains signal must be detected,
before the device will switch to Corridor Mode
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Alternatively to using the sliders, some lines and points in the graph can be dragged
to adjust the configuration.

12.3.17 DALI 102

Product group

LED
Pawer on level: e (=100 %) Do nothing
System failure level: S # Do nothing
Min level: (G — (=1 %)
Max level: (S E— (=3 %)
Fade rate:

Fade time:

Extended fade time basad:

Extended fade time
multiplier:

=]| *Operating mode can either be 0 or

Operating mode: 128 *l between 128 and 255

Short address: 7] = ;Eg\c‘:;gdnd;sdssc;n either be 255 or
Scenes

Scene 0:  |[255[% Scened: (28515 Scened:  |255[5 Scene 12: (25505

Scene 1@ 255/ Scenes: (28515 Scene9:  |285[5 Scene 13: 2555

Scene 2: (2555 Scene6: (2851 Scene 10: [25B[%| Scene 14: (255 (%

Scene 3¢ 255/ Scene7: (25513 Scene 11: [255[% Scene 15: 255 (%

Groups
Group 0 Group 4 Group 8 Group 12
Group 1 Group 5 Group 9 Group 13
Group 2 Group & B Sroup 10 Group 14
Group 3 Group 7 Group 11 Group 15

. .
Description

Use the DALI 102 feature to configure DALI settings via Device features tab instead
of Commands tab.

Usage
This feature has the following parameters:

e Power on level: Light level applied when driver is powered and DALI supply is
connected, when do nothing is selected, the driver will not act upon power
on.

e System failure level: Light level applied when driver is powered and no DALI
supply is connected, when do nothing is selected, the driver will not act upon
system failure

e Min level: Minimum light level of the driver, this cannot be set lower than the
physical minimum level of the driver and cannot be set higher than the Max
level

e Max level: Maximum light level of the driver, this cannot be set lower than the
Min level

55



e Fade rate: Number of fade steps

e Fade time: This is used to indicate how long it takes to perform fade

o Extended fade time base: Used to calculate extended fade time

o Extended fade time multiplier: Used to calculate extended fade time

e Operating mode: Operating mode of the driver

o Short address: Short address of the driver

e Scenes: A configurable preset level for the driver, a driver contains 16 scenes
for which can be configured individually

e Groups: Defines in which groups the driver is located

12.3.18 DALI Power Supply
Product group
LED

% Enable ‘

Description
Use the DALI Power Supply (DALI PSU) feature to enable the device so it will deliver
the power supply for DALl communication by itself.

Usage
Select the Enable check box to use this feature.

12.3.19 Daylight override / Daylight switching
Product group
CONTROL

Enable daylight dependent override

Enable daylight dependent switching

Description
Use the DLO/DLS feature to configure the daylight dependent settings for the device.

Usage
This feature has the following parameters:

e Enable daylight dependent override: When the Enable daylight dependent
override check box is selected, the lights remain off in case occupancy is
detected.

¢ Enable daylight dependent switching: Select the Enable daylight
dependent switching check box to switch the light off in case sufficient
daylight is available.
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12.3.20 DC Emergency
Product group
FLUO, LED

[% Enable

I allow dirnming

Ernergency level:

[ [ ] )24 [=70%)

Description

This feature is used together with a DC central battery system. The device will dim to
a specific level, as soon as a DC voltage is detected at the mains input instead of an
AC voltage on the mains input of the device. The dimming of the lamps can either be
enabled or disabled during this DC Emergency operation.

Usage

Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the arc power level when in DC Emergency mode
(the label on the right gives the approximate light level percentage). Select the Allow
dimming check box to allow dimming when in DC Emergency mode.

12.3.21 Device Info
Product group
LED

Cevice model:

Drevice label:

Date/Order code:

LED reference bin code:

LED colour code:

LED bin code:

Description
Use the Device Info feature to get or set the device information which may be
luminaire specific.

Usage
Select the Device Info feature tab to read or write the device information.

57



12.3.22 Dimming Interface

Product group
LED
Dirmmi
Interface DALl =] 'mm'“g. ':'-'".""'E
® Logarithrnic
Linear
Description

Use the Dimming Interface feature to select the dimming interface for the device. The
actual options are depending on the device model:

e 1-10V

e DALI

e Dynadimmer
e No dimming
e AmpDim

¢ LineSwitch

¢ Coded Mains

When DALI has been selected, an additional setting appears with which the dimming
behavior can be set. Options are Logarithmic and Linear dimming curves.

Usage
Use Dimming Interface to select the desired dimming interface.

Product group
FLUO, LED

Interface IAutomatic selection j

Description
Use the Dimming Interface feature to select the dimming interface for the device.

Usage
The available dimming interfaces are stored in the device and therefore need to be

read out. When the interfaces are found it will be possible to select Automatic
selection (enable all interfaces), No dimming (disable all interfaces) or a single
interface.

Product group
LED
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Can be overridden by
Interface Dynadimmer -

LineSwitch

Description
Use the Dimming Interface feature to enable dimming interfaces for the device.

Usage
The available dimming interfaces are stored in the device and therefore need to be

read out. When the interfaces are found it will be possible to select and enable the
main interface. Some interfaces have the possibility to be overridden by another
interface. If that's the case the Can be overridden by part will show the other
possible interfaces that can be enabled together with the main dimming interface.

Note! Once a Can be overridden by interface was selected, the main selected
dimming interface still needs its override option to be set accordingly. This can be
done by going to the specific interface feature and enable the override option there.

12.3.23 Driver addressing

Product group
LED

DMX address:

* Enable

Group size: |2 '|

Group address: |'I v|

Description
Use the Driver addressing feature to determine the DMX settings for the device.

Usage
e DMX address: DMX address

e Enable: When the check box is cleared the grouping feature within one DMX
address is not used.

e Group size: Number of devices that operate within one group, all responding
to the same DMX address.

e Group address: Device number within the group of devices that respond to
the same address.
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12.3.24 Driver temperature protection
Product group
LED

I I I I
-55 -35 -15 5 25 45 65 85 105 125 145 165 185
Temperature (°C)

start dim: & T ) oc

Stop dim: ( T [ ] T ) |75 °C

Shut Down: ( [ ] )] aC O N/A

Dim level: [ ] )] %
Description

Use the Driver temperature protection feature to determine the temperature
protection settings for the device.

Usage
Select the Enable check box to use this feature. Use the sliders to changes the values
for this feature.

e Enable: Select the Enable check box to use this feature.

e Start dim: Set the temperature at which dimming start.

e Stop dim: Set the temperature at which the dimming stops.

e Shut down: Set the temperature at which the dim level will be set to zero.
When selecting the N/A checkbox, the shutdown temperature is not applied

e Dim level: Set the dim level for the Stop dim temperature.
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12.3.25 Dwell Time
Product group
CONTROL

Activated

Description
Use the Dwell Time feature to postpone present detection for a certain time.

Usage

This feature has the following parameters:
e Activated: Select the Activated check box to activate the feature.
e Enabled: Select the Enabled check box to turn Dwell Time on.
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12.3.26 Dynadimmer
Product group
HID, LED
% Enable
100
Time based
S0 _
Midnight shift
0 - 80 _
minutes: = u - -
70 Time: 07:00
Schedule
EHO
2
R = 50
Time Light F_ade = =
(hh:m level time =
(%) (s) _t" 40 _
23:00 |80 180 I
02:00 |50 180
20
06:00 |80 0
07:00 (91 o 10 _
09:00 j100 |0 1|1|1|1|1.|1|'1|1|1|'1'
1516 17 181520 21 2223241 2 3 4 5 6 7 8 9
Time (h)
Description

Use D

ynadimmer to create a dynamic dimming schedule over a period of time.

Usage

Select

the Enable* check box to use this feature. This feature has a number of

options, depending on the device model:

Time based: switch between absolute and relative time schedules. When the
Time based check box is cleared, the Dynadimmer schedule will use its
automatically learned midnight point as a reference for timekeeping. When the
Time based check box is selected, the reference point is the moment when
the mains are switched on. Selecting the Time based check box changes the
graph and removes its dotted midnight line. Note that not all devices support
Time based Dynadimmer.

Midnight shift: the midnight point depends on the geographical location.
Enter the midnight shift in minutes or use the midnight shift calculation
window to automatically adjust the midnight point by the specified offset. Use
the calculation button to either manually provide latitude and longitude
coordinates or to choose a predefined location. The midnight shift option is
unavailable when the Time based check box has been selected.

The midnight shift calculation dialog window looks as follows:
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Calculate midnight shift =]

From coordinates
Latitude 0 deg 0 min 0 s = N s
Longitude 0 deg 0 min 0 s ® E

Time zone 0 Daylight saving

Calculated midnight shift (min): 0

|

e Latitude: the latitude of the location in degrees, minutes and seconds. The
value that represents the degrees cannot be negative.

e N-S: the direction for latitude of the location. The user can either select North
or South value.

¢ Longitude: the longitude of the location in degrees, minutes and seconds. The
value that represents the degrees cannot be negative.

e E-W: the direction for longitude of the location. The user can either select East
or West value.

e Time zone: the time zone of the location. For GMT+1 enter 1, for GMT-1 enter
-1, and so on.

e Daylight saving: indication whether daylight saving should be dealt with or
not.

Click OK to save result of your calculation as the new midnight shift. Note that
clicking OK is not directly saving your data to the driver. To save midnight shift to a
driver you will have to write the whole feature.

Click the New button to create a default schedule or click the Plus button to add
scenes individually. Drag the points or the lines in the graph to create the desired
configuration. Alternatively, use the table to enter values directly. Remove single or
multiple table rows by clicking the Minus button.

Note! The device will follow the dimming schedule. When the light level in the
dimming schedule is below the physical min level of the selected lamp, the physical
min level will be used. However, some devices are also capable to switch off during
the dimming schedule, if a scene was configured at 0 %.

The physical min level of the selected lamp is indicated by the gray-dotted line in the

graph.

Note! This feature can contain the override check box in some cases. If the check
box is selected, that means the dim level can be overridden by other dimming
interfaces.
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* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.26.1 Physical min level

In order to see the correct physical min level of a lamp after Lamp Selection do not
forget to switch the driver off for a few seconds. After switching it on again the
selected lamp is activated. To see the physical min level of the selected lamp in the
graph, click Read on the toolbar.

12.3.26.2 Location or custom location

For some device models, only the midnight point offset is stored in the device and
NOT the (custom) location. In those cases the location information and the custom
location is only used to calculate the midnight point offset. After reading out the
device, MultiOne tries to match the midnight point offset with a location. In case the
midnight point offset does not match to a location or the midnight point offset
matches multiple locations, MultiOne will show “No location”.

For a technical description of the characteristics of the device model, like constraints
and limitations, please refer to Device-specific technical description.

12.3.27 End Of Life indication
Product group
LED

% Enable

L ] )ID h

Description

Use this feature to warn the user at the end of the guaranteed lifespan of the LED
module. Once the end of guaranteed life is reached, the device will flash the lamp for
5 seconds and then continue normal operation. LED flashing will happen every time
at startup once the device's working hours have exceeded the number of hours
specified as End Of Life. This feature uses the same burning hours counter as the
Light Source Operating Hours and Constant Light Output features.

Usage

Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the guaranteed lifetime in hours.
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12.3.28 Energy Meter
Product group
FLUO, HID

Reset meter

Energy consumed: 1,3 kWh
Total energy consumed: 1,3 kwh

Actual power consumption: 48 W

Description

Use this feature to get an indication of the (total) energy consumption of the device.

Usage

The value for Energy consumed can be reset by selecting the Reset meter check box
followed by clicking Write on the toolbar. For some drivers this check box is already
selected and grayed out, meaning that the value for Energy consumed is being reset

automatically. The value for Total energy consumed cannot be reset. The Actual

power consumption is the power currently being used.

12.3.29 FCC

Product group

CONTROL
#| Enable
Test id: 2: Unmodulated test w
ZigBee channel: Channel 25 w

Tx power: [ [ ] )| (= B89 %)
Light level: ( ] ) (= 2 %)

Description

Use this feature to enter the settings for the FCC test, and to enable the FCC test.

Usage
Select the Enable check box to use this feature. The feature has the following

parameters:

e Test id: use the drop down box to select the test.
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e ZigBee channel: use the drop down box to select the ZigBee channel for the
test.

e Tx power: use the slider or the text field to select a value. The value represents
the transmission power for the test.

o Light level: use the slider or the text field to select a value. The value
represents the light level for the test.

12.3.30 Field Task Tuning
Product group
CONTROL

E . ) " |

Description
Use this feature in combination with the EasySense so the light output can be limited
according to the selected value.

Usage

The field task tuning level is intended as maximum light level (clip level) of the
luminaire. The light output shall not be scaled against the field task tuning level.

If this level is below 100%, not the whole DALI range will be used. This is acceptable,
since when a lot of daylight is present also a small part of the range is used.
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12.3.31 Field Task Tuning / Occupancy Sensing / Daylight Harvesting

Product group
CONTROL
[ Occupancy
[® Daylight based contral
[ LED indicator
Occupancy mode:
Field task level: [ [ ] %
Eco ON level: [ ] ) %
Background light -
level: LY ) ICI o
Hold time: | ] ) min
Prolang time: | ] ] ICI min [ Infinite
Grace fading: [ ] ) I:I s
Description

This is a combined feature of Field Task Tuning and Occupancy Sensing/ Daylight
Harvesting, use this feature to ensure the correct functioning of the EasySense.

Usage
The Field task level, Background light level and ECO ON level are related to each

other. The Background light level is the light level at which the lights will glow when
no occupancy is detected, and it should be lower or equal to the Eco ON level. The
Eco ON level should be lower or equal to the Field task level and it can be overruled
with a switch. The Field task level is intended as maximum light level (clip level) of
the luminaire.

For the usage of all the other parameters, please refer to Occupancy Sensing/
Daylight Harvesting feature.
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12.3.32 Lamp Burn-in

Product group
FLUO
% Enable
Burn-in level : Use default
( [ ] ) [250 [+ 90 %]
Burn-in time: se default
[ [ ] ) IBDDEI it
Description

Lamp Burn-in prevents dimming below a predefined level in the first hours of a
lamp’s life. This is to ensure that the lamp will be properly “burned in” before
dimming.

Usage

Select the Enable check box to use this feature. This feature has of two parameters:

e Burn-in level: use the slider or the text field to select a value. The value
represents the maximum arc power level for dimming (the label on the right
gives the approximate light level in percent). Alternatively, select the Use
default check box to use the default value.

e Burn-in time: use the slider or the text field to select a value. The value
represents the time in minutes during which the burn-in level is active.
Alternatively, select the Use default check box to use the default value.

12.3.33 Lamp Selection

Product group
HID, FLUO

Selection IHID Cosmopolis 45 j
Description

Use the Lamp Selection feature to select the lamp type that is connected to the
device. Options depend on the device model.

Usage

Use Selection to select the lamp type. Note that this feature has to be read first in
order for the options to become available. To read the feature configuration, click
Read on the toolbar.
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Note! After selecting a different lamp, it is necessary to switch the driver off for a few
seconds. After switching is on again the selected lamp is activated.

12.3.34 Light Source Operating Hours
Product group
LED

] JIEI h

Description

Use this feature to manually set or reset the number of operating hours for the LED
module. This is useful when replacing the LED module, thereby resetting features like
Constant Light Output and End Of Life indication.

Usage

Use the slider or the text field to select a value. The value represents the number of
operating hours.

12.3.35 LineSwitch

Product group
HID, LED
[ Enable
High V level: ———— ®&
Low V level: & 50
Fade on time: [ I R
it ! e—
delay time:
Fade off time: [ I R
Mote 1: Low V = 0\ on the mains; High W = 208-277 W on the mains.
Note 2: When Dynadimmer is scheduled, LineSwitch can not be used
standalone. It can only be used to override Dynadimmer.

Description

This feature provides an interface for easy dimming via pilot-line or external sensor
(presence) of a group of lamps. Dimming to desired level can be controlled by
applying a 230V between the DALI inputs. The fade times can also be set using the
fade on-, fade off and switch off delay time.

Usage
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Select the Enable* check box to use this feature. This feature has the following
parameters:

e High V level: Use the slider or the text field to select a value. The value
represents the light level to be set when high voltage is detected on the mains.

e Low V level: Use the slider or the text field to select a value. The value
represents light level to be set when low voltage is detected on the mains.

e Fade on time: Use the slider or the text field to select a value. The value
represents the fade on time to be used.

o Switch off delay time: Use the slider or the text field to select a value. The
value represents the switch off delay time to be used.

e Fade off time: Use the slider or the text field to select a value. The value
represents the fade off time to be used.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.36 Load Fault Indicator Thresholds
Product group
CONTROL

Total Driver Watts at 100%:

Minimum Driver Dim Level:

Description

To allow the SR Bridge to set the DALI lamp failure detection properly, the SR Bridge
must be configurable to set a power limit that corresponds to the lamp failure level.
This involves setting the correct maximum power of all downstream drivers combined
and the minimum detection dimlevel for which the SR Bridge will not update the
lamp failure status.

Usage
This feature has the following parameters:
e Total Driver Watts at 100%: Use the slider or the text field to select a value.
This value corresponds to the maximum power of all downstream drivers
combined.
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e Minimum Driver Dim Level: Use the slider or text field to select a value. This
value corresponds to the minimum detection dimlevel for which the SR Bridge
will not update the lamp failure status.

12.3.37 Logical Signal Input
Product group
LED
% Enabled
Mode: Occupancy sensor -
Active dim level: ¢ [ a—
Inactive dim level: [ [ ] ) %
Active when LSI input is Low
Polarity:
® Active when LSI input is High
Fade on time: [ [ ] ) s
Hold off delay: ‘ [ ) ) :
Fade off time: ( [ ] ) =
Switch off delay: ( [ ] ) s
* Enable output off

Description

Use this feature to configure an additional input signal that can be used to connect

sensors (e.g. occupancy or photo sensors) to a driver without the need for a
sophisticated OLC.

Select the Enable check box to use this feature. This feature has the following

Usage

parameters:
[ ]
[ ]
[ ]

Mode: Use the drop down box to select the sensor connected to the
logical signal input.

Active dim level: Use the slider or the text field to select a value. The
specified value represents the active dim level in percent. The active dim
level is the dim level which will be used when the input voltage level is
equal to the selected polarity, i.e. the input signal is active.

Inactive dim level: Use the slider or the text field to select a value. The
specified value represents the inactive dim level in percent. The inactive
dim level is the dim level which will be used when the input voltage
level is opposite to the selected polarity, i.e. the input signal is inactive.
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Polarity: Use the radio buttons to select the polarity of the input
voltage on which LSI should be active.

Fade on time: Use the slider or the text field to select a value. The
specified value represents the fade on time in seconds. The fade on
time is the time used to softly fade from the inactive dim level to the
active dim level from the moment the LSI state becomes active.

Hold off delay: Use the slider or the text field to select a value. The
specified value represents the hold off delay in seconds. The hold off
delay is the applied delay when LSI switches from active to inactive
before the fade off starts.

Fade off time: Use the slider or the text field to select a value. The
specified value represents the fade off time in seconds. The fade off
time is the time used to softly fade from the active dim level to the
inactive dim level from the moment the LSI state becomes inactive and
the hold off delay has passed.

Switch off delay: Use the slider or the text field to select a value. The
specified value represents the switch off delay in seconds. The switch off
delay is the applied delay when the fade off time is expired and Enable
output off is enabled.

Enable output off: Use the check box to enable or disable switching

the output.
The schematic below gives a visual representation of the usage of the different
parameters.
(/
Active input voltage level .I (
| | =S
LS! input Inactive input voltage level |'| \ |
Active dimlevel | \\
| ) | 1 | | |
A g, ) | ey | |
R Al | N | |
LS| output Inactive dimlevel | // | ( // | | \I |
e | [ | | t !
! :Report Active ™ | | { | }_
Report Inactive | / '." | : |
LSI active flag | /| | 4 |
b { L K ¥ ]
: Fade on time e : Hold off delay  Fade off time  Switch off delay :
Time since last change T Time since last change 1 Time since last change
12.3.38 Lumen Level
Product group
LED

Light cutput ratio (LOR):

Lumen output:

% Luminaire efficiency correction enabled

: »
o )
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Description
This feature provides an interface for setting the lumen output value of a device.

Usage

Select the Luminaire efficiency correction enabled check box to use the Light
output ratio (LOR) slider. This slider is used to configure the range and step size of
the Lumen output slider.

The Light output ratio percentage will change the Lumen output slider min range,
max range, current value and step size by the same percentage.

12.3.39 LumiStep
Product group
LED

* Enable
Oim period: 6 Tl h

Dim level: [0 ] 31

Description
This feature provides a simplified version of Dynadimmer.

Usage
Select the Enable* check box to use this feature. This feature has the following
parameters:

e Dim period: Use the drop down box to select the wanted dim period. This is
the time period the dim level will be used.

e Dim level: Use the slider or the text field to select a value. The value
represents the dim level in percent. The dim level will be used during the dim
period.

* Note! If the device supports interface selection then this feature can only be
enabled through the interface selection and the enable will not be shown here.

12.3.40 Min Dim Level
Product group
LED

* Enable
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Description
This feature provides an interface for setting the min dim level of a device.

Usage
Select the Enable check box to use this feature. Use the slider or the text field to
select a value. The value represents the min dim level in percentage.

12.341 Module Temperature Protection
Product group
LED

® Enzble

100

30
80
70
50
50
40

Dim level (%)

30
20
10

[u] 10 20 30 40 50 60 70 80 S0 100 110 iz0 130 140
Temperature (°C)

e Bzs°c/m: R(25°C):
Start dim: ¢ T [ ] ) 2967 Q (=70°C)
Stop dim: (] [ ] )] ) 2536 Q(=75C)
Dim level: ¢ [ ] ) 10
e Lo
Description

Use this feature to regulate lamp power when the LED module gets too hot. At a
certain temperature the lamp starts to dim in order to control temperature. At a
critical temperature level the lamp will switch off completely.

Usage

Select the Enable check box to use this feature. Drag the points or the lines in the
resulting graph to adjust the configuration. Alternatively, use the sliders to changes
values directly. Based on the device model, the feature is shown in either temperature
(degrees Celsius) or resistance values (in Ohm).

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.
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12.3.42 NTC on LEDset

Product group
LED
[* Enahle
100
a0
80
70
F 80
- =0
3 a0
E 30
© a0
10
Start dim: ¥ T [ ] )] e}
Dim lewvel: { [ ] )] o
Description

Use this feature to regulate lamp power when the LED module gets too hot. At a
certain temperature the lamp starts to dim in order to control temperature. Configure
the resistance values to determine the dimming behavior.

Usage

Select the Enable check box to use this feature. Drag the points or the lines in the
resulting graph to adjust the configuration. Alternatively, use the sliders to changes
values directly.

Note! For a detailed technical description of the characteristics of the device model,
like constraints and limitations, please refer to Device-specific technical description.
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12.3.43 Occupancy Sensing / Daylight Harvesting
Product group

CONTROL
Hold time: [GE T min
Prolong time: & I:I min Infinite

Background light IS oy
level: b

Grace fading: & I:I s

x| Occupancy
% Daylight based contral
% LED indicator

Cccupancy mode: auto on/off -
Eco ON level: I — %

Description

Use this feature in combination with the EasySense to setup an occupancy sensing
and/or a daylight harvesting mode. The occupancy sensing mode configures how
light is being controlled, based on occupancy information. The daylight harvesting
mode configures how light is being controlled, based on the amount of light in an
indoor space (contribution of natural light entering the indoor space).

Usage

The Hold time is the time whereby occupancy is no longer detected but the lights
are still on and being regulated. The Prolong time is the time at which the
background level is maintained at a fixed level. Background light level is the light
level at which the lights will glow when no occupancy is detected and Grace fading is
the time during which the lights are being dimmed down from the current light level
to the background level.

The Occupancy check box enables/disables the occupancy sensing mode. The
Daylight based control check box enables/disables the daylight harvesting mode.
When the LED indicator is enabled, the 2 LED indicators on the sensor will become
active. The yellow LED indicates whether the sensor is functional. The red LED
indicates whether occupancy is detected when the hold time is not expired yet.

The Occupancy mode defines how the lights of the system will behave.
The Eco ON level is used relative to the Field task tuning level. Only difference is

that the Eco ON level can be overruled with a switch. This can result in additional
energy savings.
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12.3.44 Occupancy sharing / Group light behavior
Product group
CONTROL

%] Enable occupancy sharing

Light level to use: Background light level -

Description
Use the OS/GLB feature to configure advanced grouping settings for the device.

Usage
This feature has the following parameters:

e Enable occupancy sharing: When the Enable occupancy sharing check box

is selected, the group occupancy sharing is enabled.

¢ Light level to use: Select the Background light level or Task light level to
indicate the desired light behavior when group is occupied and group
occupancy sharing is enabled.

12.3.45 OEM Traceability
Product group
LED

OEM Traceability

GTIN (EAN13): |9999999999999 |

Identification number: |13445?44U?3?09551615 |

additional info: |Here wou can put additional inforrnation| |

Description

OEM Traceability contains two mandatory fields, the GTIN and the Identification
number of the luminaire which are used as traceability information for OEMs. The
Additional info field can be used for additional control gear information.

Usage

The GTIN always contains 13 digits, if the value given by the user is less than 13
digits, leading Os will be added till the number reach 13 digits. The Identification
number can have up till 15 digits, however, the value given by the user shall not
exceed the value shown above in the picture. The Additional info can contain a
string with the maximum length of 44.

77



12.3.46 OEM Write Protection

Product group
OEM Write Protection
Summary OEM Write Protected features
DALI PSU (De)select all
ALO DALI PSU

ALO
® ALO Min
® AOC

AOC
owpP

ECO FactoryLink
Set the OEM Write Protection password

New password:
Verify password:

The password must contain 4 numbers (0-255).

Description

OEM Write Protection (OWP) defines a password that will be set in the driver so the
data of OEM Write-protected features can only be written to the driver by providing
the configured password.

Usage

When one or more of the OEM Write Protected features check boxes are selected, a
password needs to be entered. This password must contain 4 numbers between 0
and 255. Passwords containing 0-0-0-0 and 255-255-255-255 are not allowed. The
password needs to be verified before it can be stored in the driver. Once a password
is configured into the device, it is necessary to provide the current password when
writing other features that are OEM Write-protected. These features are indicated by
a padlock icon @ in the Write screen.

When the OWP feature is read, only the values of the feature check boxes are shown
on-screen, so it is not possible to retrieve the currently configured password.

78



12.3.47 Push Button Unit LCU2070
Product group
CONTROL/ActiLume DALI

Red: [AII qroups v]

FPurple: [Gmup 1 v]

Green: [Gmup 3 v]

Yellow: [Gmup h v]
Description

The push button unit can be used to trigger one or all groups when a button is
pressed. In total there are four different buttons that can be configured.

Usage
Use the drop down boxes to select the group(s) that should be triggered when the
corresponding button is pressed.

12.3.48 Push Button Unit LCU2071
Product group
CONTROL/ActiLume DALI

Red: [Scene 1 v]

Purple: [Sceneﬁ v]

Green: [Scene 11 v]

Yellow: [Scene 16 "]
Description

The push button unit can be used to trigger a scene when a button is pressed. In total
there are four different buttons that can be configured.

Usage

Use the drop down boxes to select the scene that should be triggered when the
corresponding button is pressed.
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12.3.49 Quick Lamp Start
Product group
FLUO

% Enable

Description

When the Enable check box is selected, the lamp can be switched on immediately
without the necessity for preheating the lamp. The preheat sequence (typically
between 0.6 seconds and 1.0 seconds) will thus be skipped. This is possible because
heating of the electrodes is not turned off.

Usage
Select the Enable check box to use this feature.

12.3.50 Relay Switched Output
Product group
CONTROL

Internal relay behavior

Always stays closed

® Switches with SR input commands

Description

Use this feature to enable or disable the relay of the SR Bridge. This relay allows SR
Bridge to switch off the connected DALI drivers either via the relay (disconnect input
mains) or by giving a DALI OFF command.

Usage
Select one of the options to set the desired internal relay behavior.
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12.3.51 Step Dimming
Product group
LED

[* Enable

Mode: = Bi-level O Tri-level

Bi active dim level: [ [ ] ] %

[%] Enable

Mode: O Bi-level ) Tri-level

Tri line 1 dim level: ) ) %
Tri line 2 dim level: ( [ N %

Description
Step dimming is the basic dimming requirement for energy efficiency.

Usage

Select the Enable check box to use this feature.
Select Bi-level radio button to edit Bi active dim level.
Select Tri-level radio button to edit Tri line dim levels.
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12.3.52 Touch and Dim
Product group
FLUO, LED

Use last known level

Fower on level: I [ ) B (= 1%)

Ignore toggle limits

Description
This feature defines the startup behavior of a touch and dim controlled device after a
power failure during dimming.

Usage

When the Use last known level check box is selected, the device will start up at the
last known dim level that was used during dimming.

If this is not checked the power on level can be configured between 0 and 100% of
the light.

When the Ignore toggle limits check box is selected, the normal toggle limits are

ignored and dimming starts directly.
If this is not checked the normal toggle limits are used.
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12.4 Using the features summary

For most devices an additional tab is shown on the Device features tab, called
Summary. The Summary tab gives a compact overview of the settings that have
been entered for all the features of this device. As the features are different per
product group, the summary is also different. The features cannot be changed on the

Summary tab.

Lamp selection

Selected: HID COo 250
Dynadimmer AmpDim

Enabled: Tes Enabled: Mo

TimeBased: Mo

Mid paint shift: 0 min

Time [ Level | Fade Low percentage 60

WDHIE L &I Low woltage 195

WSHIE LUl &I High percentage 100
High voltage 230

ALD CLO LineSwitch
Enabled: Mo Enabled: Mo Enabled: Ma
Qutput: 100 % High vaoltage lewel: 100 %%
Low voltage level: 50 %

Disabled features
- CLD

- LineSwitch

- Amplim

- ALO

12.5 Saving and opening a feature configuration file

To save and open a feature configuration file, the Device features tab must be active.

Feature configurations can be saved to a file for later use. To do so, first select the
Device features tab to make feature configurations for the selected device. Then,
click the disk icon on the toolbar or select File > Save as.

File  Actions View Tools Help

@ Read @ Write @ Reset B |

A dialog window pops up that lists the features of the device:
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Save feature configuration @

Flease indicate which feature configurations need to be saved.

Features

O (De)select all

O Touch and Dim

[ Adjustable Output Current

O Module Temperature Protection
[J Constant Light Qutput

O Corridor Mode

[ Energy Meter

O DCEmergency

® Include device information in the saved file
(Xitanium 36W 0.12-0.4A 110V TD 230V 1.4)

TN T

Select any number of features and click Save. The save file dialog window appears.
Choose a location and a file name and click Save. The selected features will now be
written to the file.

It is also possible to save the device information alongside the features. This data can
later be used in MultiOne Workflow to ensure the configuration can only be
configured in the saved device model.

As mentioned before, some features can be OEM Write-protected. These features will
be marked with a padlock icon in the dialog.

Save feature configuration @

Flease indicate which feature configurations need to be saved.

Features

B (De)select all

[ & Adjustable Output Current
[ & Constant Light Output

B & OEM Write Protection

[ The device already has an OWP password
[® Include device information in the saved file
(OWP device 1.0)

@ Indicates that the feature can be OEM Write-protected.

m

In this case it is possible to save the current password alongside the features, so
MultiOne Workflow can use this password to be able to write the data of the features
that are OEM Write-protected to the driver.
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When using SimpleSet, MultiOne compares the provided password with the password
in the device before writing the new data. When there is a mismatch, an error
message will be shown.

Password failure @

The provided password was not correct.

When using DAL], it is also possible to save DALI settings along with the feature
configuration. This can be done by checking the Include DALI settings in a separate
file.

Save feature configuration @

Please indicate which feature configurations need to be zaved.

Features

(De)select all

B DALI Power Supply

m

@ Adjustable Light Output

B Adjustable Output Current

@ Constant Light Output

@ Min dim level

a Energy Meter

aoc Emergency -

The device already has an OWP password
Include DALI settings in a separate file
¥ Include device information in the saved file
(Xitanium 36W 0.3-1A 54V SR 230V 4.2)

B Indicates that the feature can be OEM Write-protected.

Note that this feature can be enabled or disabled from Preferences.

To open a feature configuration file, click the folder icon on the toolbar or select File
- Open. The open file dialog window appears. Select a file and click Open.

File  Actions View Tools Help

@ Read @ Write @ Re et |. 1

The contents of the Device features tab are updated to show the information that
was read from the file.

Only feature configurations are stored in the file. This means that a file made for a

certain device can be read into the Device features tab for a different device.
MultiOne attempts to read as many feature configurations as possible.
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Example: a feature configuration file exists that was made for device D1, which has
features AOC, CLO and MTP. A different device, D2, has features AOC, Energy Meter
and Touch and Dim. When opening the feature configuration file for device D1 while
device D2 is selected, only the configuration for feature AOC will be read, since
features CLO and MTP are not supported by device D2.

Feature configuration files can be distributed to other users of MultiOne. A typical
example is that one user prepares a feature configuration file, and then sends it to
another user who uses MultiOne Basic. This user then opens the file and configures
the connected device.

12.6 Configuring a single device

There are situations in which only one device will be configured at the time. In this
case it is not necessary to have the full functionality of the Network, including Scan
and Commission buttons. To optimize the workflow for single device configuration,
select Single device programming in the Application Mode Selector.

When Single device programming has been selected, MultiOne will automatically
scan the DALI network and select the connected device for communication. In this
mode, the Network panel is collapsed by default. If multiple devices have been
found, MultiOne will show a message and switch to regular configuring mode.

12.7 Configuring multiple DALI devices (simultaneously)

There are situations in which multiple devices need to be configured at the same
time. The procedure to simultaneously configure multiple devices of the SAME TYPE
AND VERSION is as follows (Note! this method will not work with MultiOne Basic):

1. Connect maximum 64 devices of the SAME TYPE AND VERSION, in parallel to
the DALI connectors of the USB2DALI interface

2. Connect the USB2DALI interface to the USB port (both black and red USB

plugs (USB-A)).

Connect the devices to the mains.

Start MultiOne

Choose Tools = Preferences

Clear the Write & verify check box and click OK

Click the Commission button on the Network panel to start commissioning.

Choose Actions > Add virtual device.

Select the device of the same type and version as the ones connected on the

Network panel.

10. Select the Device features tab

11. Change any of the features.

12. Click Write on the toolbar.

© XN wuv bk w
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Note! There will not be an individual confirmation for every device. So if any of them

failed to be configured, it is not known which one.

Note! Remember that applications can be affected by the availability of the short

address.

12.8 Configuring multiple DALI devices (consecutively)

There are situations in which multiple devices need to be configured one after

another. The procedure to consecutively configure multiple devices of the SAME TYPE
AND VERSION differs slightly between MultiOne Basic and MultiOne (full version).

12.8.1 MultiOne Basic

1
2.

©® N o U khw

Connect one device

Connect the USB2DALI interface to the USB port (both black and red USB
plugs (USB-A))

Connect the device to the mains

Start MultiOne

If needed, select All in the Application mode selector
Click Scan network in the Network panel to start scanning
Select File>Open to open the required feature configuration file

Select the Commands tab
At Data field, enter 255; click the Short Addr button. (See Note!)

This removes the short address; in the network the short address is shown as
'broadcast’

10. Select the Device features tab
11. Click Write on the toolbar

12. Replace device

13. Click Write on the toolbar
14. Replace device

15. Etc.

12.8.2 MultiOne (full version)

1
2.

S

Connect one device

Connect the USB2DALI interface to the USB port (both black and red USB
plugs (USB-A))

Connect the device to the mains

Start MultiOne

If needed, select All in the Application mode selector
Click Scan network in the Network panel to start scanning
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7. Select File>Open to open the required feature configuration file
8. Right click the device in the Network panel and select Reset short address

9. Select the Device features tab
10. Click Write on the toolbar

11. Replace device

12. Click Write on the toolbar
13. Replace device

14. Etc.

Note! Remember that applications can be affected by the removal of the short
address.

12.9 Configuring multiple ZigBee devices

There are situations in which multiple devices need to be configured one after
another. The procedure to configure multiple devices of the SAME TYPE AND
VERSION is described below.

Join multiple devices in a ZigBee network

Connect the USB2ZigBee interface to the USB port

Start MultiOne

If needed, select All in the Application mode selector

Click Connect to network in the Network panel to start scanning
Right click in the Network panel and select Add virtual device...
Select the device you want to configure and click OK

Configure the virtual device as desired

© 0 N o VA WwWwN

Select the virtual device in the Network panel and click Write to current
network... in the Actions menu

10. (De)select the features you want to write in the pop-up that appears and click
Write

Note! When devices of different types and/or versions are joined in the same
network, only the features that correspond to the features of the virtual device will be
configured. All other features will be ignored.

12.10 Offline feature configuration preparation

When a device or network is not present, it is still possible to prepare a feature
configuration. This might be useful when you would like to prepare a feature
configuration file that can be read at a later time, and written to the device when it is
connected. To make a configuration you need to add one or more virtual devices.
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To add a virtual device, right-click All devices in the Network and choose Add
virtual device.
Alternatively choose Actions > Add virtual device.

Identify
Scan DALL network
Commission

Add virtual device... |

A dialog window pops up that lists all devices supported by MultiOne.

Add virtual device @
Product group filter IFLUO 'I
Device [FLUO HF-RI TD 114/21/24/33 TLE E= 1.0 -

Make a selection and click OK. An item called Virtual devices appears in the
Network. Expand it by clicking the + sign to see the list of virtual devices. Note that
virtual devices do not have a short address and MultiOne will show Broadcast on the
location of the short address. Virtual devices can only be addressed using broadcast
commands.

Select a virtual device and select the Device features tab. The device features are
shown as if the device was physically connected. Configure the features as desired,
and then save the feature configuration to a file. You have now made a feature
configuration file without being connected a device.

12.11 Sending DALI commands

To manually send DALI commands select the Commands tab.

The Commands tab contains the following tabs:
e 102tab

e 202 tab

The 102 tab has the following specific pane:
e Light control
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Device features O TIETL W Traceability  Scheduler  Query  Diagnostics  Data containers DALI sniffer

102 Light control

202 - ) [0

X Synchronize actual level

Commander
[ -] [DIRECT_ARC_FOWER( =] pata: [0

*DALI Ed2 commands Result: [result]

Configuration commands

DTRO: El DTRO -= Max level Actual level -= DTRO
pTRi: [0 | DTRO -= Min level DTRO -= Fade time
oTRz: @] .- m fail level | DTRO -> Fade rate

tese

-> Power on level

Light control

This pane offers a number of buttons to immediately influence the behavior of the
device. These controls are useful when quick feedback in terms of light is desired.
Selecting the Synchronize actual level check box will reflect the actual light level in
the slider after each command.

The 202 tab has the following specific pane:
e Control Device

Device features &L TFNG M Traceability  Scheduler Query  Diagnostics  Data containers DALI sniffer

102 Control Device
202
START FT START DT STOP TEST

Commander
[ -] [DIRECT_ARC_POWERLC =] pata: [0

*DALI Ed2 commands Result: [result]

Configuration commands

otre: 1] Prolong Time: | —— (R

Get Function Test Interval: @& El

ome o] PR Ouration TestInterval: @ ) [0 |
Test Delay Time High: @ [0 |
Test Delay Time Low: @ [0 |
Test Exec Timeout: e D

Control Device

This pane gives direct access to emergency controls that immediately influence the
behavior of the emergency device. These controls allow users to get quick feedback
in terms of the behavior of an emergency device in different situations.

Both tabs contain the following panes:
e Commander

e Configuration commands
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Commander

To send a DALI command as a broadcast command, first select All devices in the
Network, then select the DALI command in the Commander pane and finally click

the Send button. To send a DALl command to a specific address or group, select the

corresponding device or group in the Network.

Note! DALI Ed2 commands are marked by an asterisk (*).

Configuration commands

Both tabs contain this pane. However, the content of this pane is different for each
tab. To manually set or get the so-called DTR (Data Transfer Register) values of the
device, use the buttons in the left part of this pane.

To use the actual DTR value of the device with a number of DALl commands, go to
102 tab to use the buttons in the right part of this pane. Besides a number of DALI
commands using the DTR value, other DALI102 commands such as Reset, Step Up
and Step Down are directly available.

To configure values like Prolong Time, Function Test Interval, Duration Test

Interval, Test Delay Time High, Test Delay Time Low and Test Execution Timeout

that are needed while using emergency commands, go to 202 tab to use the sliders
or text fields in the right part of this pane to modify their values. The allowed range

for those values is between 0 and 255.

12.12 Traceability

The Traceability tab summarizes how many times the configuration of the device was

changed, when the last configuration change happened using unknown software and

a pane showing details of the first, second and last configuration change (if present).

Total number of configuration changes: 2

| Traceability | |

Most recent configuration change with unknown software: 1 operating hours

First

Date

5/23/2014 3:07:00 PM

Software

MuttiOne Wordlow 0.6

Interface

DALI

Second

9/26/2014 2:03:00 PM

MuttiOne Wordlow 0.6

DALL

Every entry in the list shows the date of the configuration change, which software
version was used and which type of interface was used at the time of the
configuration change.
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12.13 Working with DALI command scripts

To run a series of DALI commands, a script can be created in the Scheduler tab. This
script can be executed any number of times. Furthermore it is possible to save the
script to a file for easy reuse.

i T I

Add item ltems Response Selected item

CMD For infinite
DIRECT_ARC_POWER_CONTROL : data 123 Start time 11:13:47
QUERY_SCENE_LEVEL_0: data 0 FF
End For

® Delay (ms) 100

Device address(es) [Selected device v]

Selected

[ ArcPowerControl -
Command [DIRECT_ARC_POWER_CON ~|
*DALI Ed2 commands
Clear All

Data 123

The Scheduler tab has the following panes:

Add item

o A CMD button to insert DALI commands

o A FOR button to insert a loop, consisting of a FOR and an END FOR
Selected, containing buttons to work with (Up, Down, Delete, Clear All) the

currently selected item in the schedule

Items, representing the schedule

Selected item, the settings of the currently selected item

Schedule playback buttons (Play, Pause, Stop)

To add a command to the schedule, click the CMD button. The command is added to
the schedule and it is automatically highlighted. On the Selected item pane, choose
the desired DALI command and settings. By selecting the Start time check box and
providing a time, this command will be sent at an exact moment in time.
Alternatively, commands can be sent relative to each other. Select the Delay check
box and provide a value in milliseconds to do so. At Device address you can select to
which device to send this command. You can choose between the currently selected
device, a broadcast or one of the 64 available short addresses (0-63). Then, select
which DALI command will be sent by using the two drop down boxes; the first selects
the command group and the second selects the actual command. If a command
parameter is required, enter it into the Data field.
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Note! DALI Ed2 commands are marked by an asterix(*).

By repeatedly clicking the CMD button, a series of DALI commands can be created.
Each command has its own settings.

A schedule can also contain loops. A loop has a FOR-item, one or more commands,
and finally an END FOR-item to mark the end of the loop. Click the FOR button to
create a loop. By default, the loop will run infinitely (that is, until schedule playback is
manually stopped or paused by clicking Stop or Pause). To change the number of
times the loop will be executed, select the FOR-item and enter a value for Maximum
count on the Selected item pane.

To rearrange the schedule, select a command and use the Up and Down buttons to
move this up or down respectively. Delete a command by clicking the Delete button.
To clear all the commands use Clear All button.

To start, pause, or stop a schedule playback, use the Play, Pause and Stop buttons.
If the command is a query, the return data of the executed command will be
displayed.

To save a schedule to file for later use, click the disk icon on the toolbar. Alternatively,
select File > Save or File > Save As. Choose a location, a filename and click Save.

The schedule has now been saved.

To open a previously stored schedule, click the folder icon on the toolbar.

File  Actions View Tools Help
@ Read @ Write @ Resct |. )

Alternatively, select File > Open. Choose a schedule file and click Open. The
Scheduler tab now shows the schedule from the file.
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12.14 Querying devices

To automatically execute a number of standard DALI query commands select the
Query tab.

Device features ~ Comman...  Traceability — Scheduler Diagnostics

[ Enable DALIEd 2
DALI Ed 1
Status 194 Max level 254 Scene level 0 255
Control gear present 255 Min level 126 Scene level 1 255
Lamp failure 255 Fower on level 254 Scene level 2 255
Lamp power on 0 System failure 254 Scene level 3 255
Limit error 0 Fade time/rate 7 Scene level 4 255
Reset state 0 Groups 0 -7 0 Scene level 5 255
“ersion number 1 Groups § - 15 0 Scene level 6 255
Extended version 0 Random address H 125 Scene level 7 255
Content DTR 0 3 Random address M 17 Scene level 8 255
Content DTR 1 100 Random address L 172 Scene level 9 255
Content DTR. 2 2 Missing short address 255 Scene level 10 255
Device type 0 Fower failure 255 Scene level 11 255
Physical min 126 Scene level 12 255
Actual level 255 Scene level 13 255
Scene level 14 255
Scene level 15 255
DALI Ed 2

To make sure that the information in the Query tab corresponds to the selected
device, click Read on the toolbar.

File  Actions View Tools Help
"o Read @ )Write (@ Reset |b -

12.15 Accessing diagnostics

Some devices from the product groups HID, LED and CONTROL support diagnostics.
To access these diagnostics, select a device in the Network and select the
Diagnostics tab. Upon clicking Read on the toolbar, the device’s diagnostics
information will be read and displayed. Note that some diagnostics might be OEM
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Readout-protected and require a password before being able to read. Diagnostics for
a HID device might look as follows:

Single values

System starts

System uptime (h)

Lamp uptime {h)

lgnition driver attempts

lgnition lamp attempts

Failures

Tatal energy consumed (Wh)

Energy consumed (resettable) (Wh)
24h reset expirations

Thermal Guard protection

EOL driver incandescence failures
EOL lamp incandescence failures
EOL driver arcing failures

EOL lamp arcing failures

EOL driver failure LED module voltage
EOL lamp failure LED module voltage
Driver ignition timeouts

Lamp ignition timeouts

8

Histograms

=70{ =
71..804 =
g1.904 =
91..1004 =
101..11090 =
111..12090 =
121..1300 =
131..140¢0 =
=1404 =

LED module voltage histogram (WAC)

1200
1000 1
BOD
600
400
200
o4

=]
=]
=]
[=]
[=]
[=]
(=]
(=]

==30 A
=29..-20 A
-19..0
70

71..80
81..84
85..88
§89,.92 4
93..94
a5..96
=06

Driver temperature histogram (°C)

A brief explanation of all HID diagnostics is given below.

Table 1 HID diagnostics

Diagnostic

Description

System starts

System uptime (s)
Lamp uptime (s)

Ignition driver attempts
Ignition lamp attempts

Failures

Total energy consumed
Energy consumed
(resettable) (Wh)

24H reset expirations

Thermal Guard Protection

Number of times the HID driver was switched on (via
the mains).
Total time the HID driver was on.

Total lamp burning time.

Number of times the HID driver attempted to ignite a
lamp.

Number of times the HID driver attempted to ignite
the lamp, since last lamp replacement 2.

Total number of failures detected by the HID driver.

Total energy consumed by the HID driver.

Energy consumed since last user-reset.

HID driver was operating for more than 24 hours; any
failures blocking driver to operate the lamp are
cleared

Thermal Guard activated as a consequence of high
temperature level.
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EOL driver incandescence
failures

EOL lamp incandescence
failures

EOL driver arcing failures

EOL lamp arcing failures

EOL driver failure lamp
voltage
EOL lamp failure Lamp
voltage

Driver ignition timeouts
Lamp ignition timeouts

Cycling driver failures

Cycling lamp failures

Extinguished failures
driver

Extinguished failures
lamp

Mains high failures

Mains low failures

Bus failures

Vmid failures

Short circuits

ZCD failures

Over Power Protection

failures
Invalid lamp table failures

End-Of-Life situation showing incandescent mode of
operation of the lamp.

End-Of-Life situation showing incandescent mode of
operation of the lamp, since last lamp replacement 2.
End-Of-Life situation showing an arcing mode of
operation of the lamp.

End-Of-Life situation showing an arcing mode of
operation of the lamp, since last lamp replacement 2.
End-Of-Life situation showing a lamp voltage level
that was out of operating range.

End-Of-Life situation showing a lamp voltage level
that was out of operating range, since last lamp
replacement 2.

Failed to successfully ignite the lamp.

Failed to successfully ignite the lamp, since last lamp
replacement ?.

Cycling of the lamp (extinguished for more than N
times subsequently) [where N depends on lamp
typel.

Cycling of the lamp (extinguished for more than N
times subsequently), since last lamp replacement
[where N depends on lamp type] 2.

Detection of an extinguished lamp.

Detection of an extinguished lamp, since last lamp
replacement ?.

Mains voltage level detected that was too high to
continue operation.

Mains voltage level detected that was too low to
continue operation.

Bus voltage level detected that was out of operating
range.

Midpoint voltage level detected that was out of
operating range.

Short circuit detected in the lamp connection.
Critical failure detected in lamp or driver.

Over power detected.

HID driver switched-on with a non-supported or
corrupt lamp table selected.

a) lamp replacement triggers an erase of predefined lamp-specific items such as ignition attempts, lamp errors.
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Diagnostics for a LED device might look as follows:

Single values Histograms

LED module voltage (V) 0 1000 29

LED module dim level (%) 100 800

LED module temperature (*C) Unavailable 600 E2R

Output curent (mA) 0 400

Driver temperature ("C) 28 200 5
Mandmum recorded driver temperature (C) 44 a

Minimum recorded driver temperature (°C) 23 21..26 =60
Mandmum recorded LED module temperature (C)  Unavailable g-.20 3780
Minimum recorded LED module temperature (T} Unavailable LED medule voltage (V)

System starts [ -

System on time (h) 156 1000

Module an time () 0 ﬁ 415

Mains overvoltage count 1476 ic{z 0 0O 0o 0
Short circuit False D T o oo
Open circuit False ﬁ "D‘: E S § E
Module NTC missing True - § § § g "
Madule light reduction active False ©
Module temperature too high Falze Output current (m)

A brief explanation of all LED diagnostics is given below.

Table 2 LED diagnostics

Diagnostic Description

LED module voltage (V)
LED module current (mA)
LED module dim level (%)

LED module temperature
(°C)

Driver temperature (°C)

Represents the output LED module voltage.
Represents the output LED module current
Represents the current dim level set by the LED
driver. Takes into account all factors that can
influence dimming like Constant Light Output,
Module Temperature Protection, all dimming
interfaces etc.

Represents the LED module temperature. Available
only when Module Temperature Protection is
selected and an NTC value is selected.

Represents the internal driver temperature. It does
not represent Tcase Of the driver. Though there is a
correlation between Tcase and internal driver
temperature, the difference can vary depending on

current setting of driver.
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System starts

System on time (h)

Module on time (h)

Module energy consumed

Short circuit

Open circuit

Module NTC missing

Module temperature
reduction active

Module temperature too
high

Mains too low

Adjustable Startup Time
active

Represents the number of times the LED driver is
powered ON.

Represents the hours the LED driver is ON. (LED
module is OFF)

Represents the number of hours the LED module is
powered ON.

Represents the energy consumed by LED module
alone. Only output parameters (LED module voltage
and current) are used to calculate energy. The LED
driver energy consumption is not accounted. Hence
it does not represent true input energy
consumption of the LED system.

This indicates if output LED module is shorted.

This indicates if output LED module is open or not
connected to LED driver

This indicates missing NTC on the LED module.
Available only when Module Temperature
Protection is selected and 10k NTC is selected.
Missing NTC flag will not be activated if 15k+390 Q
NTC is selected.

This indicates light level reduction due to module
temperature being active.

This indicates whether the LED module temperature
exceeds 90 °C causing module to turn OFF.

This indicates that the LED driver is not operating
since input voltage at power ON is too low.

This indicates that the LED driver is in the startup
phase as defined by the Adjustable Startup Time.
For example if the Adjustable Startup Time is set to
20000 ms, and the diagnostic information is read at
startup within 20 s, this check box will be selected

indicating startup condition.

Some LED drivers only support a subset of diagnostics. It might look as follows:
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Single values

System on time (HH:MM) 02:43
Module on time (HH:MM) 0243
System starts 730
Maxdmum recorded driver temperature {“C) S0
Minimum recorded driver temperature (°C) 13

Madmum recorded LED module temperature (C) &4
Minimum recorded LED module temperature (C) 16

Mains overvoltage count 2

Table 3 Subset of LED diagnostics

Diagnostic

Description

System starts

System on time (h)

Module on time (h)

Maximum recorded driver
temperature (°C);
Minimum recorded driver
temperature (°C)
Maximum recorded
module temperature (°C)
Minimum recorded
module temperature (°C)
Mains overvoltage count

Represents the number of times the LED driver is
powered ON.

Represents the hours the LED driver is ON. (LED
module is OFF).

Represents the number of hours the LED module is
powered ON.

Maximum driver temperature ever reached during
the lifetime of the driver.

Minimum driver temperature ever reached during
the lifetime of the driver.

Maximum module temperature ever reached during
the lifetime of the driver.

Minimum module temperature ever reached during
the lifetime of the driver.

Number of times the mains exceeded the maximum
allowed mains voltage level.
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12.16 Working with the DALI Sniffer

Start Sniffing
Options
O Auto scroll

0 Auto save

Browse...

None selected...

*DALLI Ed2 commands

e Start Sniffing/Stop Sniffing: When clicked, starts/stops the actual sniffing

e Auto scroll: When checked the result window automatically scrolls to the
latest entry.

e Auto save: Automatically save the sniffing results to the selected file

e Browse...: Select file to store sniffing results.

To save the result to a file that is not the auto save file, click on the save button in the
menu bar.

File  Actions View Tools Help

© o @ L

An example:

Timestamp Eg:le[sl{eu&:} fctween, Answer Data Address Command D Command Emor
6/12/201509:48:53.4 |0 Write 0550 SHORT_2 Cmd_144 QUERY_STATUS
6/12/201509:48:53.4 | 20820 Read B2 - - 130
6/12/2015 09:48:53.5 32550 Write: 0591 SHORT_2 Cmd_145 QUERY_CONTROL_G...
6/12/201509:48:53.5 | 20460 Read OxFF - - 255
6/12/201509:48:53.5 | 29140 Write 0552 SHORT_2 Cmd_146 QUERY_LAMP_FAILU...
6/12/201509:48:53.5 | 20850 Read xFF - = 255
6/12/201509:48:53.6 | 32090 Write x0593 SHORT_2 Cmd_147 QUERY_LAMP_POW...
6/12/2015 09:48:53.6 34450 Write: x0554 SHORT_2 Cmd_148 GQUERY_LIMIT_ERROR
6/12/201509:48:53.6 | 36450 Write 0595 SHORT_2 Cmd_149 QUERY_RESET_STA...
6/12/201509:48:53.7 | 55260 Write 0557 SHORT_2 Cmd_151 QUERY_VERSICN_N...
6/12/201509:48:53.7 | 20480 Read 08 - = 8
6/12/201509:48:53.8 | 27870 Write Dx05FF SHORT_2 Cmd_255 QUERY_EXTENDED_...
6/12/201509:48:53.8 | 35340 Write x0558 SHORT_2 Cmd_152 QUERY_CONTENT_D...
6/12/201509:48:53.8 | 20910 Read 12 - = 18
6/12/201509:48:53.8 | 34080 Wite x055C SHORT_2 Cmd_156 QUERY_CONTENT_D...
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Column 1 - Timestamp: The time stamp of the message

Column 2 - Time delta between The time difference in microseconds

Frames (us) between two consecutive commands

Column 3 - Answer The answer type, either an read or write
message

Column 4 - Data The data being send or received

Column 5 - Command ID The ID of a command (only if a
command is used)

Column 6 - Command The known DALI command name, if no

command then decimal value of the
received Data

Column 7 - Error The kind of error that might have
occurred

The color of a line in the sniffer pane indicates the type of the DALl command.

12.16.1 Sniffing with multiple interfaces
It is possible to sniff multiple DALI networks on the same PC. To do this:

e Connect multiple USB2DALI devices to the PC.

e In MultiOne go to the Preferences window and select the Show connection
settings on startup option.

e Start MultiOne multiple times and select different interfaces.

e Once all MultiOnes are started, start in each MultiOne the sniffer.

Note! When multiple MultiOnes connect to the same interface, the sniffing will not
work anymore.

12.17 Art-Net export functionality

Art-Net has the possibility to export different features from multiple drivers to
extensible markup language (.xml) type of file for easy usage later on. The export
functionality is available under the Actions menu.

Actions
@ Scan Art-Net network Ctrl+D

Export diagnostics...
Export all features...

Read from current device (group) Ctrl+R

Write to current device (group) Ctrl+ W

Reset Device

The following two options are available to the user:

- Export diagnostics: Retrieve the diagnostic values from the selected device(s)
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- Export all features: Retrieve all features from the selected device(s)

If the user selects either one of the options he will then be able to select the drivers
from which he would like to export the information from. The shown list contains all
available devices from the network, even the ones that do not support this
functionality, but the user will be unable to select the non-supported devices.

Selected devices

4 device(s) found

® UID Device name Supported
(%] | 50:68:41:54:B0:33 LED HP 350W 1.10 1.16 Yes
x| |50:68:41:54:B0:34 LED HP 350W 1.10 1.16 Yes
x| |50:68:41:54:B0:35 LED HP 350W 1.10 1.16 Yes
[x] | 50:68:41:54:B0:36 LED HP 350W 1.10 1.16 Yes

Once all needed devices are selected the user could start exporting the data.

Flease wait while exporting diagnostics...
Processing Device: 50:68:41:54:B0:33: LED HP 350W 1.10 1.16
Progress: 4 device(s) remaining

During the export the user will receive short updates on what device currently is
being processed and how many devices are still remaining.

Summary
Time: 0 hours 0 min 6 sec 501 ms
Result: 4 device(s) exported successfully
= ] - - LED
- - MultiOne Diagnostics
Address Device Version Result Date version version mody
voltal
% | 50:68:41:54:B0:33 |LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM |2.10.0.0 o 0
% |50:68:41:54:B0:34 (LED HP 350W 1.10|1.16 0K 8/27/2015 12:07 PM |2.10.0.0 o 1]
(% |50:68:41:54:B0:35 [LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM |2.10.0.0 o 0
(% |50:68:41:54:B0:36 [LED HP 350W 1.10 |1.16 0K 8/27/2015 12:07 PM |2.10.0.0 o 0

Once the export is finished the user is then presented with the final result in a simple
overview. The user could make a selection of what devices it would like to save the
data from and save this to a supported file type.

12.18 The logging window

The logging window shows the communication related to the features currently
being read or written or when DALI commands are sent or received through the
USB2DALI interface.

p Addre De ptio R e -
29-3-2012 13:41:16 3 Caonstant Light Output: readin... |success
29-3-2012 13:41:16 3 Constant Light Qutput: readin,.. |success
29-3-2012 13:41:16 3 Adjustable Light Output: readi... |success
0.3.2017 1341 44 Arnnbiirn: reading walis Lirre hd
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Timestamp
The time the feature was read or written or the time the command was sent. The
format of the timestamp is: <date> <time>.

Address
The short address to which the feature or command was sent. In case Broadcast is
mentioned, all devices are addressed.

Description
The name of the feature or the actual DALI command.

Result
Result of the communication.

12.19 Setting preferences

MultiOne has a preferences window that allows you to customize the way MultiOne
works. To access the preferences window select Tools > Preferences.

Tools

Preferences. ..

Connection settings. ..

Power supply [
[TTESMmIres.

The Preferences window that pops up allows you to set MultiOne preferences.

12.19.1 General preferences

e . |

General preferences

General O Show application mode selector on startup

DALI [0 Scan network automatically on startup

R [ Start maximized on startup

[ Play sounds whenfeatures are configured

O Play sounds when features or diagnostics are read
[ Prevent sleep maode

[ Write & verify

When write & verify is enabled an additicnal verification step will be
carried out after writing a feature configuration to a device.

Show connection settings [c.'ml',-r when no interface connectad -

Re-enable all warnings

| I T |
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The following list summarizes the available preferences and gives an explanation for
each.

¢ Show application mode selector on startup. When MultiOne is started you
are presented with a screen that allows you choose an application mode,
based on the tasks you would like to perform. You can disable this screen by
clearing the Show application mode selector on startup check box.
Changing this settings only takes effect once MultiOne is restarted.

e Scan network automatically on startup. By selecting this check box
MultiOne will automatically initiate a network scan on startup. Changing this
settings only takes effect once MultiOne is restarted.

e Start maximized on startup. By selecting this checkbox MultiOne will be
started full screen. Changing this settings only takes effect once MultiOne is
restarted.

¢ Play sounds when features are configured. When this check box is selected,
MultiOne will make a sound when a feature configuration is (un)successfully
written to a driver.

¢ Play sounds when features or diagnostics are read. When this check box is
selected, MultiOne will make a sound when a feature configuration is
(un)successfully read from a driver, or when diagnostics are (un)successfully
read from a driver.

e Prevent sleep mode. By selecting this check box MultiOne will prevent the PC
or laptop from automatically entering the sleep mode as long as MultiOne is
active.

o Write & verify. By default, MultiOne will write parameters to the connected
device(s) without checking the state of the device afterwards. By enabling
Write & verify you force MultiOne to perform an additional verification step
by reading back the written parameters immediately after writing. If the
received values differ from the parameters that were written, MultiOne will
alert you that there is a deviation between MultiOne and the device.

The Write & verify uses different status icons then Write. When a Write &
verify action is successful the icon will be totally green . When the verify
action has failed the entire icon will become red. ¥ A pending action will be
displayed is a grey icon. i+ /1t is also possible that a part of the Write &
verify fails. To help indicate where the action failed, two extra icons exist. If the
first half of the icon is red and the second part is grey, B then the write
action failed. When the first part is green and the second part is red, E& then
the read action has failed. It is possible to have both the Write & verify as
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orange, {this means that the feature might not be configured correctly
because the program could not verify the result.

¢ Show connection settings. Changing this setting allows you to control the
appearance of Connection Settings window when MultiOne starts. The
following options are possible:

Only when no interface connected: Connection Settings window will be
shown on startup only when there are no interfaces connected.

Always on startup: Connection Settings window will always be shown on
startup.

Never on startup: Connection Settings window will never be shown on
startup.

e Re-enable all warnings. MultiOne produces a number of warnings that you
can disable by selecting their Don’t show this message again check box. If
you would like to reset all suppressed warnings click the Re-enable all
warnings button.

12.19.2 DALI

Preferences @

DALI preferences

General

DALT scan method By short address "|
DALI
e Scanning by short address does not change the random address of any
Proxy device in the network. Choose this option if random addresses should

not be affected.

Save DALI configuration

e DALI scan method. Changing this setting allows the user to control the way in
which a DALI network is scanned. The following options are possible:
By short address: DALI devices are scanned by their short address.
By random address: DALI devices are scanned by their random address.
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e Save DALI configuration. Checking this setting give the users the ability to
save DALI settings when saving a feature file. By clearing this check box, the
save DALI settings option will not appear when saving a feature file.

For more details on the DALI scan methods, see Identifying devices.

12.19.3 Updates
Preferences @

Updates preferences

General

MultiOne updates* Automatic - Check only "|
DALI . . . . .
Automatically check for updates; notify when an update is available
Updates
Proxy * Takes effect once Multione is restarted

e MultiOne updates. Changing this setting allows the user to control the
update method of MultiOne. The following options are possible:
Automatic - Check, download, install: MultiOne will automatically check for
updates and if available download and install them automatically.
Automatic - Check, download only: MultiOne will automatically check for
updates and if available download them. The user then has to agree to let
MultiOne update itself.
Automatic - Check only: MultiOne will automatically check for updates and
notify the user if a new version is available. The user can then allow MultiOne
to download and install the update.
Manual: MultiOne will do nothing and the user has to force MultiOne to
check, download and install any update.
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12.194 Proxy
e 5

Proxy preferences

General

[ Enable proxy
DALI

Updates | |

Proxy | |

Proxy settings take effect once MultiOne is restarted

Check Connection

e Proxy address
The proxy address that needs to be used by MultiOne.

Examples:

1.1.1.1 or proxy.mycompany.com

http://1.1.1.1 or https://1.1.1.1

https://proxy.mycompany.com or https://proxy.mycompany.com
e Proxy Port

The port that needs to be used by MultiOne

Examples:

80, 8080, 8888

12.20 Manually selecting the USB2DALI interface

MultiOne will automatically detect the USB2DALI interface that is connected to the
PC. However when multiple interfaces are connected it will use the interface on the
port that is found first. It is possible to manually change the port that is used by
selecting Tools = Connection settings.

Preferences..

| LConnection settings...

FPower supply 3

[

In the pop-up window it is then possible to select the desired port.
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Connection settings @
® DALl O ZigBee O Art-Met O SimpleSet
Interface selection
Selected interface MutiOne DALI interface -
Selected port 17A717294007 -
| =n

Notice! The unique id of the interface is shown at the port selection. This, to be able
to identify which interface is used by which MultiOne instance (when configuring
devices in parallel using multiple instances of MultiOne).

12.21 Enabling/Disabling the power supply of the USB2DALI interface

The USB2DALI interface will automatically detect if the DALI bus is powered by
another device (for example a DALI power supply). If the DALI network is not
powered, it will use its internal power supply.

Tools

Preferences...

Connection settings...
L[\ Power supply >|

Enable power supply

| Disable power supply

If, during operation, the DALI network is changed in a way that it requires the
USB2DALI interface to switch on or off its internal power supply, you can do so using
the option Tools = Power supply.

12.22 Supported features

The table below gives an overview of all features that are supported by MultiOne and
to which product groups they apply.

Table 4 Supported features

Device feature Product group
LED HID FLUO CONTROL
Indoor Outdoor
0-10V / 1-10V X
1-10V X

ActiLume General

ActiLume Mode

ActiLume Scene

Active Cooling X
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Adjustable Light
Output

Adjustable Output
Current

Adjustable Startup
Time

AmpDim

Constant Light Output
Coded Light

Coded Mains

Coded Mains
Standalone Receiver
Correlated Color
Temperature
Corridor Mode

DALI 102

DALI Power Supply
Daylight override /
Daylight switching
Device Info
Dimming Interface
Driver addressing
Dwell Time
Dynadimmer

DC Emergency

End Of Life indication
Energy Meter

FCC

Field Task Tuning
Field Task Tuning/
Occupancy Sensing /
Daylight Harvesting
Lamp Burn-in

Lamp Selection
Light Source Operating
Hours

LineSwitch

Load Fault Indicator
Thresholds

Logical Signal Input
Lumen Level
LumiStep

Min Dim Level

xX X
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Module Temperature X X

Protection

NTC on LEDset X X

Occupancy Sensing / X
Daylight Harvesting

Occupancy sharing / X
Group light behavior

OEM Traceability X X

OEM Write Protection
Push Button Unit X
LCU2070

Push Button Unit X
LCU2071

Quick Lamp Start X

Relay Switched Output X
Step Dimming
Summary

Touch and Dim
Logical Signal Input

X
x

X X X X

12.23 Device-specific technical descriptions

For a detailed technical description of the characteristics of the devices, please visit
the product-specific Philips web sites:

Table 5 Product-specific Philips web sites

Product group Visit:

LED www.philips.com/Xitanium

HID www.philips.com/Xtreme

FLUO www.philips.com/HFR-Intelligent
CONTROL www.philips.com/Actilume

12.24 Error handling
12.24.1 Reporting and correction of errors/warnings when reading from a

feature configuration file
When, after opening a feature configuration file, incorrect parameters are detected,
MultiOne tries to correct these parameters for the selected (virtual) device. When a
correction is made, a red border will be shown. In cases when no logical correction
can be made, an orange border will be shown.
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http://www.philips.com/Xitanium
http://www.philips.com/Xtreme
http://www.philips.com/HFR-Intelligent
http://www.philips.com/Actilume

12.24.2 Reporting of errors when reading from a device

When after reading from a device a mismatch is signaled between the parameters of
the device and MultiOne, MultiOne will not correct the parameters, but will show a
red border.

12.24.3 Reporting of errors when entering incorrect values in a feature
Entering an incorrect value for a parameter will be indicated by a red border.

12.25 Troubleshooting

Problem: After starting MultiOne, no devices are displayed.

Solution: Click the Scan network button on the Network panel to start discovering
the devices in the network. If the devices connected have already a DALI short
address this will not be changed. Devices without a short address will be
programmed with a short address. When the Commission button is clicked, the short
addresses of all connected devices will be renewed, whether they already had a short
address or not.

Problem: I would like to assign a specific short address to a device.
Solution: First scan the network for devices. Right-click the device you would like to
give a short address and select Set short address.

=) All devices
W (- Xitanium 17W 0.3-1824V TR/l 93n 40
‘... Userdefined groups Identify

Add to user-defined group  »

Set short address... |
Reset short address

A dialog window will appear in which you can enter the desired short address.

Custom short address @

Short address ) =

[ ok [ cancel |

Click OK to program the short address into the device.

Problem: I would like to remove the short address of a device.
Solution: First scan the network for devices. Right-click the device whose short
address you would like to remove and select Reset short address.

- All devices

I () it anium 17W 0.3 ;

‘... User-defined groups Identify
Add to user-defined group  »
Set short address...

L\ Reset short address
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You will be informed that the short address was reset.

Short address reset @

The short address has been reset to 255.

Problem: I would like to configure the special features of the connected device.
Solution: After scanning the network for devices, a device has to be selected by
clicking it in the Network. Select the Device features tab. The related features will
appear. To update the view to the actual status of the features, click Read on the
toolbar. If you now change any of the features, and want this to be stored into the
device, click Write on the toolbar.

File  Artions View Tools Help

‘o Read (@ Write ') Reset |-' -

Problem: I would like to know more technical details of a device.
Solution: Please refer to the Philips website for more detailed information
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13 Keyboard shortcuts

Keyboard shortcuts can make it easier to work with MultiOne without using the

mouse.

Table 6 Keyboard shortcuts

USB2DALI interface

USB2ZigBee interface

The File menu
Ctrl+O

Ctrl+S

Ctrl+Shift+S

Alt+F4

The Action menu
Ctrl+D

Ctrl+Q

Ctrl+R

Ctrl+W

The Tools menu
Ctrl+M

The Help menu
Shift+F1

F1

Working with feature configuration files

Open a feature configuration
file

Save a feature configuration
file (Save)

Save a feature configuration
file

(Save As)

Not supported
Not supported

Not supported

Exit MultiOne
Working with devices

Scan network
Commission

Read from current device
Write to current device

Scan area

Not supported
Not supported
Not supported

Open the Application mode selector

Open the Getting started document
Open the User manual
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14 Software Update

MultiOne has the possibility to update itself to a newer version. This can be done
either automatically or manually and can be set in the preference window, see the
Setting Preferences for more info.

Preferences @

® Show application mode selector on startup™®
[ Scan network automatically on startup*
[0 Write & verify

When write & verify is enabled an additional verification step will be
carried out after writing a feature configuration to a device.

MultiOne updates*® [Mmaﬁc-[}:edcmﬂy V]
Automatic - Check, download, install

Automatically check|p ;o - Check. download on is available
Automatic - Check onl
Manual k

Re-enable all warnifig=
\l * Takes effect once MultiOne is restarted m

If the preference is set to Manual then the user can check for an update on MultiOne
by selecting Help > Check for updates option.

Check for updates

) Supported devices...

@ Getting started...  Shift+F1
@ User manual... F1

About...

After a manual update check, or by using the automatic options, the update status
near the Help menu will show if a new version is available. The user can then decide
to continue downloading/updating by either using the update status or the Help
menu to carry on.

Download and Update now
Supported devices...

@ Getting started...  Shift+F1
@ User manual... F1

* Update is ready to be installed.
Download and Update now
About... . View changes in version 2,6.0 o]

After downloading the update status will inform the user to restart to continue.

Help () Update will be installed on next start.

Restarting MultiOne will install the update.
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)

Downloading & Installing updates
Updating Philips MultiOne Expert Release to the latest version.

wyUpdate is downloading and installing updates for Philips MultiOne Expert Release.
This process could take a few minutes.

+/" Downloading update
Backing up and updating files
Backing up and updating registry

) Optimizing and executing files

A successful update of MultiOne will be shown in the update status.

sfully updated to
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15 Copyright

Copyright © 2017 Philips Lighting Holding B.V..

All rights reserved. No part of this publication may be reproduced, transmitted,
transcribed, stored in a retrieval system or translated into any language or computer
language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual or otherwise, without prior written permission from Philips. Brands
and product names are trademarks or registered trademarks of their respective
companies.
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16 Disclaimer

Philips makes no warranty of any kind with regard to this material, including, but not
limited to, the implied warranties of merchantability and fitness for a particular
purpose.

Philips assumes no responsibility for any error that may appear in this document.
Philips makes no commitment to update nor to keep current the information
contained in this document.
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17 Limitations of damages

The vendor will not be liable for any indirect, special, incidental or consequential
damages (including damages for loss of business, loss of profits, or the like), whether
based on breach of contract, tort (including negligence), product liability or
otherwise, even if the vendor or its representatives have been advised of the
possibility of such damages and even if a remedy set forth herein is found to have

failed its essential purpose.
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